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Welcome From The Chief Editor
I’m beginning to think that the “J” in January must
stand for “Judgement.” Given how January went
down, most people would be hard pressed to
disagree.

shadow of a doubt), and vehemently denied by
Armstrong, the interview removed any questions of
doubt and removed all speculation. The confession
also revealed the lies that Armstrong had been living
and espousing ever since the late 1990s.

Judgement: Good

Currently under a lifetime ban from cycling, his
public confession is unlikely to have any effect.
Officials for the USADA, the UCI (International
Cycling Union), and the WADA (World AntiDoping
Agency) are unanimous in their decisions to remain
steadfast on the lifetime ban. Instead, they all agree
that Armstrong must testify (minimally) before the
USADA, under oath, about his “doping” activities,
and give a full accounting about how the illegal
activities were carried out. It remains to be seen if
that will happen.

On January 17, 2013, former
forum
moderator
Joble’s
estranged wife was found guilty
of two counts of “deliberate
murder” in the October 13, 2011
shooting deaths of Joe Gable
(Joble) and Sunday Bennett at
Joble’s home in Helena, MT.
While sentencing is scheduled
for March 1, 2013, she could
face a minimum of life in prison.

Summary

In the 17 months since Joble’s murder, the entire
judicial process that lead up to the conviction has
often times resembled a circus. There were
numerous attempts by Joble’s estranged wife and
murderer to either derail or delay the process,
including two suicide attempts and delays for
psychological examinations.
Finally – and at last – Joble can rest in peace, with
justice having been served. It is still hard to believe
that he is no longer here, among his friends and
family. Taken from us much too early, Joble is still
missed by those who knew him.
Judgement: Bad
It’s no secret that I’m an avid bicycling enthusiast, as
my monthly editor’s column picture has frequently
depicted me on a bicycle ride. On January 17, 2013,
former seven time Tour de France winner (former,
since he has had all of his seven Tour de France
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titles stipped by the United States AntiDoping
Agency, and his 2000 Olympic bronze medal taken
away by the United States Olympic Committee)
admitted in a televised interview with famous former
talkshow host Oprah Winfrey that he had taken
performance enhancing drugs to help procure those
victories.
Love him or hate him (there seems to be no middle
ground), Armstrong’s confession rocked not only the
sporting world of bicycling, but the entire sporting
world. Long speculated, never proven (beyond a

There’s a couple of common lessons to be had
between the two cases of judgement here. First, you
never know when your whole world will come to a
screeching halt. Everything we hold dear and sacred
– even our lives, themselves – can be stripped away
in the blink of an eye. Second, any attempt to “win at
all costs” usually bears a cost that none of us can
afford to pay. ‘Nuff said.
Until next month, I bid each of you serenity, peace,
happiness and prosperity.
CORRECTION

CORRECTION

CORRECTION

In the January 2013 article "Nexus 7 To PCLinuxOS
Connection Guide," when making the mount point, the
line should read mkdir p ~/000_USB/Nexus_7. In the
article, the command is misisng the p switch, which
will cause an error in creating the mount point. The
author regrets the oversight, and any problems it might
have caused.
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Windows Migration: My Journey to PCLinuxOS
by Meemaw
I’m sure I’ve told this story before: I used Windows at
home until about 2005.
I had a brother visiting one weekend in 2004, when
my computer crashed. My brother, who had more
computer experience than I, tried to recover my OS,
but was unsuccessful. At that point, he said, “Maybe
you should switch to Linux.” (“What’s Linux? I’ve
never heard of it before.”) I’m sure at this point you
can imagine what he told me next, because you’ve
heard it yourself. He uses Linux and was happy to
tell me all about it. Of course, I did have to pay
someone to restore Windows, but I vowed I would
never do that again, and started researching Linux
myself.
I found loads of Linux sites and read bunches of
material. After seven years, I still remember a few
sites that I thought were helpful to me.
(www.linux.com,
www.linux.org,
http://www.linuxrsp.ru/winlinsoft/tableeng.html and
http://www.zegeniestudios.net/ldc/)
The last one is a site where you can try to determine
which distribution is best for you, and every time I
used it, I came up with a new idea or two. Many of
the sites also directed me to DistroWatch to choose
my distribution. I used it long enough to read the
reviews and to see the variety of distros in
existence, and started with the top 10 or 15 in their
list. After that, I did my own research.
When I learned about Live CDs, I thought they
would be the best route for me to learn about the
distributions and, hopefully, discover which one was
best for me. I downloaded Live CDs of Mandriva
Move, PCLinuxOS, Ubuntu, eLive and several
others. For a while, I had several Live CDs, and

PCLinuxOS Magazine

every day I would boot one up and experiment. I
took notes on what I was learning as well, in order to
remember which distro did what I wanted. I very
quickly realized that PCLinuxOS did everything I
wanted it to do, and it was easy to use. A couple of
other distros worked well, but I always kept coming
back to PCLinuxOS.
My stumbling block was a printer that I had owned
for a while. It just wasn’t recognized in any of the
distros I tried, and a couple of the hardware
compatibility lists I found kept saying “doesn’t work
under Linux”. However, one day I discovered the
printer had quit working. When I checked the lists for
suggestions for a new one, I found that most all of
the HP’s were compatible. I’m still using the HP that
I bought from a retiring friend shortly after that.
Now that everything worked under Linux, I could
install my favorite distro. However, I was still sort of
torn between PCLinuxOS and another distro. I
solved that by taking a deeper plunge, partitioning
my hard drive and dual booting the two different
distros. I tried to alternate between PCLinuxOS
and the other distro, but I still kept booting
PCLinuxOS more often. So one day, I cleaned
the whole thing off and installed PCLinuxOS.
That was version 0.93, and I’ve been using
PCLinuxOS ever since. I started with KDE, but
have tried Gnome, LXDE, Xfce and e17. I use
Xfce now on both of my machines.

could
install
Firefox,
GIMP,
Inkscape,
OpenOffice/LibreOffice and VLC on the work
computer, too. I was able to learn quickly, and since
then, I have expanded the new program list to
include Hugin, Scribus, Chrome, and even Opera.
I think I managed to save them some money as well,
installing open source programs in place of the
proprietary ones they would have had to purchase.
First Step (on your Windows Computer)
One of your first steps should be to list what
programs you need. When I started, my list would
have been similar to the list below:
Web Browser (Internet Explorer)
Office Suite (MS Office)
Email (Outlook/Outlook Express)
Financial (MS Money or Quicken)
Desktop Publishing (Print Artist  I used to make my
own greeting cards  or Publisher)
Drawing program (MS Paint)
Games

In the course of my research, I discovered that
many programs have Windows, Mac AND Linux
versions. When I found that out, I started trying
the Windows versions of the programs to learn a
little about them. I have some very
understanding employers, too. They don’t
mandate what program I should use for my job,
as long as things are done correctly. As a result, I
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Windows Migration: My Journey to PCLinuxOS
Photo Manipulation (Photoshop)
File Manager (Windows Explorer)
CD/DVD Burner (Nero)
CD/DVD Player
(Windows Media Player or
PowerDVD)
File Archive Manager (WinZip)
As you know, you would have to pay extra for the
codecs to play DVD’s, or buy a player program if you
didn’t have one. As you may already be aware,
most of the extra programs cost quite a bit.
PowerDVD is about $50 now. Print Artist cost about
$50 last time I looked, and the basic version of
Photoshop is at least $150. I couldn’t afford to keep
buying new versions.
Intermediate Step
(still on the Windows Computer)
You can begin to replace some of your favorite
programs with their open source equivalents. You
will learn about these programs, and your transition
to Linux will be smoother. You’ll probably save some
money, too.
Web Browser (Firefox)
Office Suite (OpenOffice)
Email (Thunderbird)

Financial (KMyMoney or GnuCash)
Desktop Publishing (Scribus)
Drawing program (OpenOffice Draw)
Games
Photo Manipulation (GIMP)
File Manager (Windows Explorer)
CD/DVD Burner (ImgBurn)
CD/DVD Player (VLC)
File Archive Manager (WinZip)
Most of these are open source, and free.
Switching over (Linux Computer)
Now that you’ve installed Linux, you know what
programs to use and you already know how to use
them! I have listed the KDE programs I am familiar
with, but there are many more choices.
Web Browser (Firefox)
Office Suite (OpenOffice/LibreOffice)
Email (KMail or Thunderbird)
Financial (KMyMoney or GnuCash)
Desktop Publishing (Scribus)
Drawing program (OpenOffice Draw)
Games
Photo Manipulation (GIMP)
File Manager (Dolphin)
CD/DVD Burner (K3b)
CD/DVD Player (VLC)
File Archive Manager (Ark)
Each different Desktop Environment
you try will have its own programs
included. All of these are open
source and most likely included on
your Live CD, or readily available
from the repositories.
My Current List
I will include the list of programs I use now in
Xfce. I am not telling you what to use at all. I am
only demonstrating that even my choices have
changed in the seven years since I first installed
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PCLinuxOS, and yours will, too.
Web Browser (Chromium Browser – the open
source “parent” to Google Chrome)
Office Suite (LibreOffice)
Email (Chrome  all my email is web based)
Financial (GnuCash)
Desktop Publishing (Scribus)
Drawing program (OpenOffice Draw & Inkscape)
Games (I’m not a big gamer, so it’s only Solitaire,
Gweled, Mahjong, etc)
Photo Manipulation (GIMP)
File Manager (Thunar)
CD/DVD Burner (XFBurn)
CD/DVD Player (VLC)
File Archive Manager (File Roller)
Enjoy your journey! To help you plan your road map
in making your transition to PCLinuxOS, I’ve
compiled a list of common Windows programs – and
their PCLinuxOS equivalents. To keep the “list”
pared down a bit, I’ve only listed some of the more

popular Windows programs. Usually, those are the
ones most people are using. However, if you don’t
find your favorite Windows program listed, and you
are curious to know what the PCLinuxOS equivalent
is, don’t hesitate to ask in the PCLinuxOS forum.
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Windows Migration: What Software Do I Need?
by Meemaw
Now that you have experimented with Linux, or even
installed a version, you remember a certain program
that you need. In Windows, it was called ABC. Does
Linux have a program that does the same thing?
What‘s it called? When I first converted to Linux, I
found an equivalent programs list that helped me
find what I needed. Sadly, this list is outdated, and
many of the programs on it are either not up to date
or have been discontinued.
In this article I will discuss equivalent programs for
the ones you had in Windows. All of the Linux
programs I mention can be found in the PCLinuxOS
repositories. Some of the more popular choices for
Windows programs will be in Red text, and Linux
equivalents will be in Blue. There’s no possible way
to anticipate EVERY user’s needs, so we’ll touch on
what we think are the most common application
equivalents.
When you tried a Live CD, Live DVD or Live USB,
you found that most of them had several useful
programs already installed (web browser, text editor,
cd burning program, music player, video player,
calculator, etc). Some of them differ depending on
which desktop environment you were using. We’ll
start with the Web Browsers.
Web Browser
For a while, the only browser was
Internet Explorer. Now, however,
there are several others;
Internet Explorer, Mozilla Firefox, Google Chrome,
Opera, Safari

PCLinuxOS Magazine

Mozilla Firefox, Konqueror,
Midori, SeaMonkey, Epiphany

Chromium,

Opera,

Notice that Firefox, Chrome/Chromium and Opera
are common to both groups. I always liked that
because I have to use Windows at work. But
because I use Linux at home, I can use the same
browser in both places. We will find that several
other programs have Linux versions PLUS Windows
and Apple versions as well. This also helps those
who want to try these programs before they commit
to switching.
EMail Clients
All of my email is webbased, so I can access it on
both of my computers but others want a program on
their computer that they can use to receive their
email. However, if you are the sort that likes to have
and use a dedicated email client, you have plenty of
choices to choose from.
Outlook, Outlook Express, Mozilla Thunderbird,
Lotus Notes, Eudora
Mozilla Thunderbird, Evolution, KMail, Claws Mail,
Eudora, Postler
Address Book
Outlook/Outlook Express
Evolution, KDEPIM, gaddr, rubrica, osmo, contacts
Instant Messenger/IRC Client
Yahoo Messenger, AIM, Trillian, Pidgin, XChat,
MSN, mIRC

Pidgin, XChat, KVirc, Kopete, aMSN
Video/Audio Conference
NetMeeting, GoToMeeting
Ekiga (formerly GnomeMeeting)
VoIP
Skype, Linphone, Blink, Cisco IP Communicator,
Ekiga, Google Talk, Mumble, Ventrilo
Skype, Linphone, Ekiga, Decibel, Mangler, Google
Talk plugin, Twinkle
File Manager
Windows Explorer, Xplorer2, Total Commander,
Unreal Commander, Nomad.NET, etc.
Konqueror, Thunar, Dolphin, Nautilus, Midnight
Commander, XFE
Archiver (Compress and decompress files for
storage or email)
7Zip, WinZip, WinRAR, PKZip
ArK, File Roller, Xarchiver
Text Editor (When you don’t need a
whole office suite)
Notepad, Wordpad, Sticky Notes
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KWrite, Kedit, Gedit, Kate, Mousepad, Leafpad,
scite, Medit, Nedit, Geany
PDF Viewer
Adobe Reader, Foxit Reader
Kpdf, Evince, Adobe Reader, Foxit Reader, Epdf,
Okular
PDF Creator
Adobe
Acrobat,
OpenOffice, Scribus

Ghostscript.

LibreOffice,

Ghostscript, Kghostview, LibreOffice, OpenOffice,
ps2pdf (a printtofile function in many programs),
Scribus
Office Suite (most including word processor
spreadsheet, presentation creator, drawing program
& database)
Microsoft Office, Microsoft Works, Lotus Symphony,
OpenOffice, LibreOffice
LibreOffice, Calligra (formerly KOffice), Abiword
(word processor only), OOo4Kids
Scanner Controls
Each scanner cd generally includes its own
program, VueScan
XSane,
SimpleScan,
Kooka,
VueScan,
SimpleScan, Gnome Scan,
gscan2pdf

CD/DVD Burning

Picture Viewers

Nero, Roxio Easy CD Creator,
ImgBurn, Windows Media Center

Windows Fax & Image Viewer, IrfanView, XNView,
ACDSee

K3b, GnomeBaker, Iso Master,
XFburn,
Grafburn,
Brasero,
Audacity, Mencoder, DVD::Rip,
AcidRip

GPicView, Ristretto, picturewall, ephoto, Eye of
Gnome, viewnior, kuikshow, Cornice, flphoto, Imgv,
gliv, GQView, Shotwell, fSpot, gthumb, Mirage,
Gwenview, IrfanView

System Configuration

Graphic Editor (simple)

Control Panel, SysConfig, Regedit

Paint

PCLinuxOS Control Center, KDE Control Center,
Gnome Control Center, XFCE Settings Manager,
LXDE Control Panel

Kpaint,
Mypaint

Audio/Music Players
Windows Media Player, WinAmp, iTunes, VLC
MPlayer, AmaroK, Noatun, VLC, Clementine, Totem,
XMMS, KsCD, XBMC, Exaile, Banshee, DeaDBeeF,
Listen, Rhythmbox, Songbird, Xfmedia, Parole
Video Players
Windows Media Player, iTunes, VLC, Power DVD,
RealPlayer & others

Tuxpaint,

MTPaint,

Graphic Editor (like Photoshop)
Adobe Photoshop, GIMP, Paintshop Pro, Corel
PhotoPaint
GIMP,
ImageMagick,
Cinepaint,
KolourPaint, Gnome Paint, Krita

MTPaint,

Vector Graphics Editor
Adobe Illustrator, Corel Draw, OpenOffice Draw,
LibreOffice Draw, Inkscape

MPlayer, XBMC, VLC, Xine, Parole, Xfmedia

Inkscape, (Sketch), Sodipodi, OpenOffice Draw,
LibreOffice Draw, Dia, XaraExtreme

Video Creators

3D Graphics

Windows Movie Maker, Adobe Premier, Video Studio
4, (and some video cameras have their own
programs on CD)

3D Studio Max, Maya, POVRay
Maya, Blender, POVRay

Avidemux, Cinelerra, Cinepaint, Kdenlive, LiVES,
Kino, Openshot
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Screenshots
Insystem <Shift>+<Print Screen>, SnagIt
KSnapshot, Shutter, screenie, Xfce Screenshooter,
MTPaint Screenshot, scrot
Desktop Publishing
Microsoft Publisher, Adobe
PageMaker, Scribus
Scribus
Personal Finance Manager
MSMoney, Quicken, Quickbooks, MoneyDance,
GnuCash, KMyMoney, grisbi, skrooge
GnuCash, KMyMoney, grisbi, Money
Manager EX, Homebank, iFreeBudget,
skrooge
HTML Editor
Microsoft FrontPage, Dreamweaver,
many webbased sites, LibreOffice, OpenOffice
KompoZer, LibreOffice, OpenOffice, Bluefish, Blue
Griffon, many webbased sites
CAD
AutoCAD
Blender, Qcad, OpenCascade, KiCAD
Space Simulator
Open Universe, Celestia, Google Earth
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Open Universe, Celestia, KStars, Marble, Google
Earth, Stellarium
Genealogy
Family Tree Maker, Legacy

same as PCLinuxOS … FREE. Along the way, you
may just make some new friends.
You can also take a look at some additional
resources that might be able to help direct you to
Linux equivalent software.

Gramps

PCLinuxOS Forum (we can’t leave this out … other
PCLinuxOS will probably be your best, if not
friendliest, resource)

Summary

Linux App Finder (a well maintained database of
Linux equivalent software)

While it would be nearly impossible to list every
possible Windows application and the PCLinuxOS
equivalent, you can see that PCLinuxOS isn’t
lacking when it comes to providing the software that
you need to get your tasks completed. You would be
hard pressed to find a Windows application that
doesn’t have a Linux equivalent. In many instances,
Linux has more to offer than what’s available in the
Windows universe.
It’s important to remember two things that are
somewhat linked. First, you don’t download software
from the internet and install it on your computer, like
you do/did under Windows. Second, you install
software ONLY from the PCLinuxOS repository.
Installing software from outside the official
PCLinuxOS repository will render your installation
ineligible for support. When you install software from
outside the repository, no one knows exactly what
changes were made to your installation, which could
be reason for the problems you may be
experiencing. There are very few exceptions to the
second “rule.”

alternativeTo (just software, regardless of platform)
alternative.to (not only software, but alternatives to
just about anything)
OSalt (find open source alternatives to most any
software title)
Enjoy your journey!

I hope that we’ve covered at least some of the most
common and popular Windows applications, along
with the Linux equivalent. If there’s something that
you use that we didn’t cover here, don’t hesitate to
ask others in the PCLinuxOS forum what they
recommend. The best thing about it is that the
software in the PCLinuxOS repository is priced the
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Joe Gable: Fabled Foibler

Joble

I miss you in the forum makes my heart to cry
Though you're no longer here I'll never say goodbye
I always see you on your motorcycle avatar
I made oh what fun for me
But I will never understand some things in life
I guess they just must be
A confidant to many you were so kind
Gentle goodhearted hero all come to my mind
Giving help to others in the forum you never did fall short
Many times it was for me
But I will never understand some things in life
Or why they have to be

MP3

OGG

Great sense of humor or how you loved to tease
Fun loving friend you always put us at our ease
I have your picture with its treasured smile oh what style
And you will be missed by me
But I will never understand some things in life
I wish they would not be
PCLinuxOS Magazine

Page 9

Mark's Quick Gimp Tip & Double Take

Mark's Quick Gimp Tip

Did you ever need to remove
an object from a photo and
found yourself using the clone
tool for endless hours? The
process involves grabbing
various bits of background elements and
overlaying/cloning
them
onto
the
foreground. Well, the Gimp plugin called
Resynthesize comes to the rescue! And
the great news is, it's available in the
PCLOS repository! Once installed, you're
just a couple of clicks away from modifying
images in a revolutionary way. In the
example below, I was able to remove an
entire building and have background
elements redrawn automatically.
It's

seamless. Simply select the
element you want removed,
then
go
to
Filters>Map>Resynthesize.
In the new popup window you
can accept the default settings
or tweak them a bit by varying
the sample of neighboring
horizontal and vertical pixels.
Click Okay and the plugin
does the rest!
Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

©2013 by Mark Szorady. Distributed by georgetoon.com
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Making Xsane A Little More Sane
by Paul Arnote (parnote)

OS/2 users. Of course, none of this would mean
anything without understanding SANE.

Back in October 2009, Meemaw covered some of
the basics of using and setting up a scanner under
PCLinuxOS, with Xsane. If you are new to Xsane, or
if you need to brush up on your scanning basics, I
recommend following the link and rereading
Meemaw’s article. This month, we’ll revisit Xsane
and explore some of the more advanced things you
can do with it.

SANE is a crossplatform backend for standardizing
access to raster image acquisition hardware. The
SANE API is in the public domain, and is released
under the GNU General Public License. Ports to
MacOS X, OS/2 and Microsoft Windows are either
already done or in progress.
From the SANE project site:
SANE is a universal scanner interface. The value of such
a universal interface is that it allows writing just one
driver per image acquisition device rather than one driver
for each device and application. So, if you have three
applications and four devices, traditionally you'd have
had to write 12 different programs. With SANE, this
number is reduced to seven: the three applications plus
the four drivers. Of course, the savings get even bigger as
more and more drivers and/or applications are added.
Not only does SANE reduce development time and code
duplication, it also raises the level at which applications
can work. As such, it will enable applications that were
previously unheard of in the UNIX world. While SANE is
primarily targeted at a UNIX environment, the standard
has been carefully designed to make it possible to
implement the API on virtually any hardware or operating
system.

Xsane is a crossplatform application, helping to
provide a graphical interface to the SANE backends.
Aimed at UNIX and Linux users, Xsane also
provides a graphical interface for Win32 users and
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While SANE is an acronym for “Scanner Access Now
Easy” the hope is of course that SANE is indeed sane in
the sense that it will allow easy implementation of the API
while accommodating all features required by today's
scanner hardware and applications. Specifically, SANE
should be broad enough to accommodate devices such as
scanners, digital still and video cameras, as well as
virtual devices like image file filters.

If you're familiar with TWAIN, you may wonder why there
is a need for SANE. Simply put, TWAIN does not separate
the userinterface from the driver of a device. This,
unfortunately, makes it difficult, if not impossible, to
provide network transparent access to image acquisition
devices (which is useful if you have a LAN full of
machines, but scanners connected to only one or two
machines; it's obviously also useful for remotecontrolled
cameras and such). It also means that any particular
TWAIN driver is pretty much married to a particular GUI
API (be it Win32 or the Mac API). In contrast, SANE
cleanly separates device controls from their
representation in a userinterface. As a result, SANE has
no difficulty supporting commandline driven interfaces
or networktransparent scanning. For these reasons, it is
unlikely that there will ever be a SANE backend that can
talk to a TWAIN driver. The converse is no problem
though: it is pretty straightforward to access SANE
devices through a TWAIN source. In summary, if TWAIN
had been just a little better designed, there would have
been no reason for SANE to exist, but things being the
way they are, TWAIN simply isn't SANE.
In the previous article, Meemaw covered how to set
up your scanner. Granted, support under SANE is
often hit and miss. This is, of course, nothing new to
Linux users. Many manufacturers worry only about
supporting Windows. Even when a scanner or
imaging device is recognized by SANE, there’s no
guarantee that all of the features of your scanner will
be recognized or that they will all work like they were
intended to under Windows. You can check here to
see if your scanner is supported by SANE. Be sure
to look for your specific scanner model. Close
doesn’t count. Sometimes, on models with close
model numbers, you will find one model that works,
while the next one does not.
Personally, I have a HewlettPackard ScanJet 8250.
SANE recognizes my scanner as a model 8200, and
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Making Xsane A Little More Sane
Image Scanner
This is probably what most people will use Xsane
for. There aren’t many of us around that don’t have a
bunch of photos stuffed into a box in the closet. How
nice would it be to have those images in a digital
format that you can use?

the automatic document feeder simply will not work.
Still, I feel fortunate to have a scanner model that
works under Linux and SANE. I have two other
scanners, and one of those will not work under
Linux. No way, no how. One is a Canon FB620P
LiDE scanner that uses the parallel printer port. It
works, thanks to a recent addition to the SANE
backends, albeit limitedly and very, very slowly. Still,
it works and the quality is acceptable. The other is a
Lexmark printer and scanner combination. Linux will
recognize the printer part of the combo, but not the
scanner.
To be sure you’re getting a scanner that you can
use, I would suggest looking through the supported
models list to find one that is reported as working,
and that has the features you are seeking. Then, go
to Ebay and look for a used model of that scanner.
You’ll also save yourself some money – and hassles.
My HP ScanJet 8250 originally sold for $1000 when
it was brand new, but you can now get it on Ebay for
$55 and free shipping.
Meemaw did an outstanding job of covering the
basics of Xsane in her previous article. But, there
are a lot more capabilities hiding under the hood.
Each of the various capabilities of Xsane can be set
up under the Preferences > Setup menu. So, let’s
take a look at some of those features.
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To get started, select either “Viewer” or “Save” as the
target (note the target icon to the left of the drop
down selections). The difference between “Viewer”
and “Save” is that the former will allow you to view
the image in the viewer window before saving it,
while the latter will simply save the file directly,
without you being able to view it before it is saved. If
you use the viewer selection, you can save the

displayed image by selecting File > Save Image
from the Viewer window menus.

Another nice feature of Xsane is that it will
automatically number your images, giving each a
unique filename when it saves them. All you have to
do is set up the first number in the naming scheme,
and Xsane will take care of incrementing the number
with each picture you scan, and append that number
to the end of your filename. I have Xsane set up to
save images to the ~/Pictures/Scanner directory
(which I created), and the filename set up as out
0001.png for the first image I scanned. From there
on out, Xsane increments the number at the end of
the filename, even between reboots and subsequent
launchings of Xsane.
Make sure you’ve set up the rest of you options, as
Meemaw covered in her October 2009 article. Then,
place the image(s) you wish to scan on the glass of
the flatbed scanner, and close the lid. Click on the
“Acquire Preview” button in the Preview window.
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window. You can choose to save it as a JPG, PNG,
PDF, PNM or TIFF file.
Home Copy Machine
Let’s say your brother or sister comes over for dinner
and you have prepared an old family recipe. Your
sibling asks for a copy of the recipe, which you
happen to have in your grandmother’s handwriting.
You could get in the car and run off to the local copy
center and make a copy – or you could just head
over to your computer and scanner, and make a
copy on your own printer in less time than it would
take you to make the round trip to the local copy
center. Convenient, huh?

Before we can use Xsane and our scanner as a
copy machine, we first need to set things up in
Xsane. Go to the Preferences > Setting menu in
Xsane, and choose the third tab.
If this is your first time setting up this part of Xsane,
you may not have a printer listed. You may need to
select the “Add printer” button at the bottom of the
window. Next, specify the name of your printer on
the Name field exactly as it appears in your list of
printers. While your mileage may vary, I have found
that I can simply accept all of the rest of the default
settings in this window.
Next, select “Copy” as the target for your scan. In
the second row of controls, you can set how many

You can place either a single image, or multiple
images on the flatbed scanner. Meemaw covered
how to use “Auto Raise” in the preview window to
select single items when multiple items were placed
on the scanner bed. I take a slightly different
approach. Click on the first icon at the top of the
Preview window, and then simply draw around the
image you want to scan by clicking and dragging
your mouse, leaving a little extra “wiggle room”
around the edges. Don’t worry. You can crop the
image closer later in your favorite image editor, such
as GIMP. When you are satisfied with your selection
in the Preview window, select the “Scan” button in
the main Xsane window.
Now, depending on whether you selected to save
the file directly or if you selected to view the image
before saving it, your scanned image will be either
written to your hard drive or displayed in the Viewer

PCLinuxOS Magazine

Page 13

Making Xsane A Little More Sane
Multipage Document Creation
Without a doubt, I have found this feature of Xsane
to be the most useful. Most of the time, when
scanning documents, we have more than one page
to the original document. Sure, you could save each
individual page as a separate PDF file. If I wanted
them all placed into one PDF, I could use pdfjoin
from the command line, and combine all of the
pages into one single PDF file.

Select “Multipage” as your scan target, and make
adjustments to the rest of your settings so they meet
your needs.

However, selecting “Multipage” as your scan target
eliminates all of that postscanning work. Instead, it
will take each page that you scan and place them
into one PDF file for you.

copies you would like to print, the printer you want to
print to (just in case you have more than one printer
to choose from), and the positioning of the scanned
image on the copied page. Now, select the rest of
your settings (you may want to change from “Color”
to “Lineart” if you’re copying documents or
handwritten text), and place the original on the glass
of your flatbed scanner. In the Preview window,
select “Acquire Preview,” then crop the scan area as
we previously described. In the main Xsane window,
select the “Scan” button, and after a brief wait
(providing you’ve done everything properly), your
scanned image should start printing on your
selected printer.
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When you select “Multipage” as your scan target,
another window will open up. On the top line of that
window, you can specify the path and filename you
want to use when saving your multipage file. On the
second line, you can specify what type of file you
want Xsane to create. Your choices are PDF, PS or
TIFF.
Now, all you have to do is scan each page of your
document. As you scan each page, the scans will be
listed in the middle of the window, in the “Pages”
section. If you accidentally get some of your pages
out of order, don’t worry. Highlight the page in the list
that you want to move, then click on the up or down
arrow buttons to move it to its new location. After
you’ve scanned all of your pages, select the “Save
multipage file” button at the bottom left. Voila! You
have just created a mutlipage file from a series of
scans.
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Home Fax Machine
Last month, in the January 2013 issue of The
PCLinuxOS Magazine, I covered how to send faxes
from PCLinuxOS. While I personally think it would be
easier to create a multipage file, and then send that
file with your fax modem, Xsane also includes a
feature that will allow you to send a fax from your
scans, as you scan them.
Select “Fax” as the target for your scans, in the main
Xsane window.
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Enter the telephone number of your fax recipient in
the second line of the window below. You can
change the name of the project, if you choose. The
default is “faxproject,” and is placed in your /home
directory.
Select “Scan” in the main Xsane window. The
scanned page(s) will show up in the “Pages” section
of the Xsane Fax Project window. When you are
satisfied that you have all the pages you want to
send listed, select the “Send project” button at the
bottom of the window.
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At least, that’s how it’s supposed to work. To be
perfectly honest, I never got this feature of Xsane to
work – at all. Your mileage may vary, and I’d love to
hear from you if you are successful in getting this
setup in a manner that allows it to work. I tried the
efax0.9a fax program, which is installed with efax
gtk, the fax program we used in the January 2013
fax article. I also installed mgetty+sendfax, and was
still unsuccessful at getting Xsane to send the fax.
Oh sure, it “queued” the faxes, but they were never
sent.
Like I said when I started talking about the Fax
capabilities of Xsane, it makes a lot more sense to
me to make a multipage PDF, and then send that
from EfaxGtk. If nothing else, this provides a nice
alternative to sending faxes from Xsane.
Document Emailer
If you have a standard POP3 email account, you can
email scanned images directly to your email
recipients. It kind of shortcuts the whole process of
scanning in an image, opening your email client (or
web page), composing the message, remembering
to attach the image, then sending your email. Why
not just do it all, right from Xsane?
Before you can send an email, you will need to set
up the details of your email account in the
Preferences > Setup dialog box.
On the first line, insert your name how you want it to
appear in the “From” field of the email. On the
second line, “Reply to,” insert your return address,
which is typically the email you are sending email
from. You can insert a different email address, if you
wish. On the third line, insert the smtp server
address, provided from your ISP or mail host. On the
fourth line, insert the SMTP port (typically, 25) used
by your mail provider. On the fifth line, select ASMTP
Login, since most email accounts require
authentication these days. The sixth line is your
“User” ID, which is typically your email address. The
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seventh line is where you put the password for your
email account. You should now be set to send email
with your POP3 email account, straight from Xsane.
Select “Email” as the target for your scans, in the
main Xsane window. This would also be a good time
to make sure all of the other settings are what you
want (Color, Gray, Dithered, Lineart, scan resolution,
etc.).

second line, insert your email recipient’s email
address. On the third line, insert the subject of your
email. In the “Email Text” box, type your message to
your email recipient. Below that, check the box
“HTML email” if you want Xsane to send HTML
encoded email. Otherwise, your message will be
sent as a plain text email. You can also select the
type of file you want your scan to be saved as. Your
choices are JPG, PDF, PNG, PostScript, and TIFF.

When you select “Email” as your target, another
window opens that allows you to specify all the
specific details necessary to send your email. On the

At this point, place your original on the scanner bed,
acquire the preview, crop it, then select the “Scan”
button in the main Xsane window. The scanned file
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I temporarily saved the file as gmailsmtp.sh in
~/Downloads/Scripts. Right click on the file, go to the
“Permissions” tab, and make sure the file is marked
as executable. Now, open up another copy of your
favorite file manager as the root user, and copy the
gmailsmtp.sh file to /usr/bin.
Before proceeding, let’s test the script to make sure
it is working properly. Open a terminal session, and
enter /usr/bin/gmailsmtp.sh on the command
line.
After a short delay, you should see something similar
to
220
mx.google.com
ESMTP
f42sm17489123rvb.6. If you then type helo, you
should get something like 250 mx.google.com at
your service. Typing quit should get you 221
2.0.0
mx.google.com
closing
connection
f42sm17489123rvb.6, and your shell prompt back.

Now we need to make that wrapper available as a
local network service, so XSane can use it. Open
your favorite text editor again, and type the following
in:

will appear in the “Attachments” window, in the
bottom half of the email window. Once you are
satisfied that everything is as you intend, select the
“Send project” button at the bottom left of the email
window.
This is all fine, if you are using a standard POP3
email account. But if you are a Gmail user, you have
some work to do to get Xsane to talk to Gmail’s
SMTP servers. Initially, I honestly thought it might
not be possible. But after some digging around, I
found a four year old post on Ubuntu forums from a
user named flabdablet that solved the problem.
Instead of linking you to the actual post, I’m going to
list the instructions here, minus the typical Ubuntu
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sudo stuff that PCLinuxOS doesn’t use. I’ve tested

this, and can confirm that the instructions work
perfectly.
First, open your favorite text editor, and enter the
following (the line beginning with /usr/bin gets typed
all on one line):
#!/bin/sh
/usr/bin/openssl s_client connect
smtp.gmail.com:465 quiet 2>/dev/null

# default: on
# description: Gmail SMTP wrapper for
clients without SSL support
service gmailsmtp
{
disable
= no
bind
= localhost
port
= 10025
socket_type= stream
protocol
= tcp
wait
= no
user
= root
server
= /usr/bin/gmailsmtp.sh
type
= unlisted
}

Save that file as gmailsmtp, without any file
extension. Again, I temporarily saved the file in my
~/Downloads/Scripts directory. Once again, open
another window of your favorite file manager as the
root user, and copy the file to the /etc/xinetd.d
directory.
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If you type netstat ltn at a command prompt,
you should see a line something like this:

intended purpose is for whatever it is you are
scanning. Here are some examples.

tcp

First, let’s say that you are scanning in an image to
use as desktop wallpaper on your computer. Most
computers use a display resolution of 96 dpi (dots
per inch) for images. Hence, it makes no sense to
scan in an image at 4800 dpi if you’re only going to
use the image as wallpaper. Similarly, if you are
scanning in a document that you are preparing to
fax, it makes no sense to scan your document at
600 dpi and in color, since the maximum resolution a
fax machine can reproduce is 200 dpi with dithered
graytones. In that case, anything more than 300 dpi
and dithered gray is overkill and a waste of time and
disk storage space.

0 0 127.0.0.1:10025 0.0.0.0:* LISTEN

All that remains is to configure XSane. Under the
“Email” tab in the setup dialog box, set the SMTP
server address to localhost, the port to 10025, fill in
your Gmail account details, and select ASMTP Login
authorization.
If you’ve done everything properly, you should now
be able to send emails from your Gmail account. To
test it out, enter your email address as the recipient,
type a subject, enter some text for the message, and
hit “Scan” in the main Xsane window. The image will
appear in the “Attachments” section of the email
project window. Once everything is as you want,
click on the “Send project” button. Your email to
yourself should be on its way.
A Few Scanning Tips
Tip #1.
Get out the Windex (or other glass cleaner), some
plain white paper towels (the ink on the printed
paper towels can cause streaks) … and CLEAN the
glass that makes up your flatbed scanner’s imaging
surface. It’ll save you time later on when you are
enhancing and cleaning up your scanned images.
You will reveal plenty of imperfections to “fix” in just
the original image. There’s no need to add more
work, simply because you introduced more dirt and
imperfections into the scanned image. Plus, no one
wants to see your fingerprints and other smudges –
which will show up in the scanned image.
Tip #2.
Choose your scan resolution wisely. Higher
resolution scans take more time to complete, and
they also make larger files – sometimes
HUMONGOUS files. Keep in mind what your
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On the other side of that spectrum, if you are
planning on making a copy of an image that is larger
than the original (say you are taking a 4” x 5” image
and wanting to make an 8” x 10” image from it), it is
wise to gather and preserve as much of the image
detail as possible. You can do this by increasing the
scan resolution. Keep in mind that the resulting file
will be quite large.
Tip #3.
Get rid of the blank space around an image. If you
are scanning in a wallet sized school picture of your
niece or nephew, you certainly don’t need all of the
rest of that blank space surrounding your image.
Without cropping too tightly, select only the image
and maybe a little of the surrounding space around
the image. Your scans will not only have a smaller
image file size, but your scan will also complete
much quicker.
Tip #4.
On a similar note, if you are only interested in just a
portion of an image, crop the image in the Preview
window to scan only that specific portion of the
image you are interested in. Using this method, I
was able to create a “closeup” image of my

grandfather, who was standing in a large group of
kids outside the schoolhouse where he went to
school. In the smallish original image, taken in 1911,
it was hard to distinguish that it was him. But
afterwards, by paying close attention to my scan
resolution (high) and scanning only that portion of
the image, I was able to make a passable 5” x 7”
image of my grandfather, separated out from the
crowd of other students. It is, to this day, the only
image we have of my grandfather from when he was
a child.
Summary
Without a doubt, Xsane is a very powerful tool to use
with desktop scanners. Like I stated earlier, there
are a lot of features hiding just below the hood.
Once you understand how to manipulate, setup and
use those features, Xsane becomes even more
powerful. There are more advanced Xsane
functions, but what we have covered here should
cover the needs of 98% or more users needs.
It’s a shame that the scanner market, after 20 years,
still isn’t unified. Some manufacturers, such as
Epson, only support the TWAIN standard. The sad
thing about TWAIN is that it is rather “Windows
centric.” Although TWAIN claims to support Linux, it
has never really caught on with Linux users. Even
on their forum, the most recent posts about Linux
are three and four years old. Meanwhile, other
scanner manufacturers, such as Hewlett Packard,
support both the TWAIN and SANE standards,
giving users the best of both worlds while supporting
more than just Windows.
Of course, as Linux users, we’re used to
manufacturers not releasing detailed hardware and
interface specifications, since they don’t want to
reveal “trade secrets.” Linux users, as has been the
case all along, have been forced to “roll their own”
solutions to get image scanners operational under
Linux. Maybe when – not if – Linux gains a greater
market share among desktop computer users, the
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scanner manufacturers will start to provide better
Linux support for their hardware.
There is a new crop of scanners coming onto the
scene in recent years that work without the need to
be connected to your computer. Rather, these
scanners are a standalone, allinclusive solution.
Their imaging capabilities are self contained on their
ROM, and they store images on either a USB flash
drive or on SDHC/microSDHC memory cards. With
this newer crop of scanners, there are no more
concerns about drivers, driver compatibility or
whether an OS is supported. All you have to do is
scan your images, and save them to the memory
card. Then, pop the memory card into the card
reader on your computer, and you have immediate
access to your newly digitized images.
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Posted by gandy, January 11, 2013, running KDE4.

Page 19

GIMP 8: Colorizing a Photo
by Meemaw
I have several old photographs of my grandparents.
One of my favorites is a shot of my grandmother as
an infant. I have always wondered what that photo
would have looked like if color photography had
been available in 1893. I have scanned and saved
this photo to try to colorize it.

It’s also a good idea to give each layer an
appropriate name to make things less confusing
during this project, since there will be several layers.
Next, you should right click on the image and create
a layer mask (Layer > Mask > Add Layer Mask)

Make a copy of this layer as well. Then you will need
to make sure that the image is not in Grayscale
mode. Go to Image > Mode > RGB and set the
mode to RGB.

Now go to colors and select Colorize. Color Balance
or HueSaturation could be used as well, but we’ll
colorize this one.

Set the background as white.

The first thing I am going to do with it is to open a
copy of the photo in Gimp so I still have the original.
This way if I mess up, I won’t have to rescan. In
addition, I am going to make a copy of that layer, so
I will still have the original I opened and can delete
any layer that’s messed up. You may try a lot of
options on this project, and having a copy of a layer
is one way to be able to undo something you did that
didn’t turn out as you wanted it. Remember, you can
always use the undo key combination <CTRL> + Z.
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For the Colorize dialog to actually come up, we need
to make sure our image is selected and not the layer
mask (below). The image is on the left and layer
mask is on the right and when either is chosen, it is
outlined in white. The image is chosen here (next
page, top).
With Color Balance or Colorize, we will now want to
try to get the image to be same color of the object
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Colors > Invert to invert the colors. Once the colors
are inverted, it will look like the original without any
color.

we want to color. I started with the skin. I made sure
I created a copy of the image and layer mask I could
use specifically for the skin.

Next I used paint brush, selected the white color and
painted. You can use the selection tool, outline the
object you are colorizing, then fill it with white, but
using the paintbrush is easier. As we did on the
other layer mask, you can outline with a smaller
brush, then fill in with a larger one.

Once you adjust the opacity on the layers, you are
done! Export your photo. As a finishing touch, I
opened the finished photo and took out the white
spots (blemishes on the original photo) using the
Clone tool, like we did the road sign a couple of
months ago.

When you choose Colorize, your photo will change
to a bluish/turquoise. Adjust the hue until you find
the color you like. Below are the the screens that I
adjusted to do the blanket in light blue.

Once you have that layer the way you want it, create
a new copy and repeat the process for another
portion of the photo. For my next layer I did the
dress.
Keep on repeating the process for every object that
is a different color. It can be quite tedious but it’s fun.
I ended up doing the skin, hair and dress and
decided against doing the blanket. >
Don't worry too much about getting the colors exact.
Changing the colors later is quite easy. If you decide
you want to go back and change a color, just select
the layer and go back to colorize (make sure the
layer mask is NOT selected).
After you have the color you want, you will now need
to select the layer mask by clicking on it. Now go to
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After you do all the layers, you can go back and
adjust the opacity on the layers to make it look a bit
more natural and not over saturated.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Page 21

Forum Foibles: PCLOS Is The BEST
PCLinuxOS 2011.6 is the best operating
system in 2011, without a doubt.
LinuxGnu

You have chosen what we here consider
the best little Linux Distro not just from
Texas but the whole world over, we as a
collective have great pride in being part of
a community that is like a large extended
family network. Hootiegibbon
This is and always will be the best
operating system I have ever had the
privelage to use. Once again , Thank
you. Duke

I want to tell all involved with PCLOS
Thank You for all you do. I have been
using Linux for around 5 years and have
used about every major, and minor, Linux
distro. Without a doubt PCLOS is the
best Linux distro available! moss870
I think that PcLinux is the best!
kyndscotsman

I have almost forgotten other distros exist.
Vote for PCLinuxOS ? What for, it's
already the best! melodie
This has to be the BEST Linux distro I
have tried so far. eddie
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I tried them all but PCLinuxOS is the best
out there. Mtack

Pclinux is the best distro out there for
the following reasons:
1. Ease of use for those coming from
the windows environment.

2. The basic apps are installed for us to
use and if not there, the repository has it
3. The forum gives very good help and
will lead beginners to help solve their
problems. ponchuk
I said the best one out there is
PCLinuxOS 2011.6. sammy2fish

Now I am happy with PCLinuxos
FULLMonty, so well done on the best
linux version there is. derekf

Anyway, I just wanted to thank you guys.
I really appreciate all the hard work you
guys put in to make this distro the best.
joepublic9

Let's just be thankful that PCLOS now
have several DEs and WMs to choose
from, and not put anymore pressure on the
devs as it is because they are really very
busy working their butts off to give us the
best. Archie
Installed and tried them all. And have
come to the conclusion that PCLinuxOS is
the very best of them all. kc1di

You just can't beat PCLinuxOS, there is no
equal. Great hardware support and a
stable rolling release is the best!
exploder

Hi pclinux team. Honestly I am newbie, but
I really used so much distributions of linux
and one of my bests is PClinuxOS.
malekcool
All the best Tex, love the PCLinuxOS,
have never used another distro, would be
a let down I'm sure. Abraxas

BTW: Welcome to the PCLOS Forum,
the best support community on the net.
Linuzoid
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PCLinuxOS is the best distro around.
Chisum

We really have the best of the best
running PCLinuxOS! It really is like a
dream becoming reality! exploder

2 months ago I installed PCLinuxOS kde
2011.09 on my acer Extens 5230E,
perfectly running since then. I have to
say  for me  it's the best distribution
ever! Thank you! hubeerh
Big welcome to the best forum in town,
lovely to have you with us. menotu
I'm using PCLinuxOS for a few days
now and I must say, it is by far the best
Linux distro I've been using until now.
renewit
When I arrived here, I was blown away
by the rock solid distro and the
absolutely best community anywhere.
And it's only gotten better over the
years! tschommer

It just clicks together here. Yes, no OS
is perfect, but this one is the best of the
Linux Operating Systems out there.
sammy2fish
Welcome to the best of the best!

Not only did you find the best os on the
planet you found the best distro and the
best friends that share yourcompassion.
I hope to see you in the sandbox.
Rudge

I don't normally do this but I just felt I
needed to say that PCLinuxOS is the
best Linux distro I have come across. I
am using the KDE version. It allows the
user easy access and what I also like is
Welcome to the best OS and forum
that it 'trusts' the use with root privileges.
around. nok
So, that all the necessary maintenance
The sandbox and the people you meet can be done. The support forum is also
there are the best friends you can have. very helpful and has helped me to make
Welcome to the best version of linux on the smooth transition. Congratulations
on great piece distro!!! oldgreygary
the net. smileeb
This distro is the best and it works
without messing about. chilly
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Most of all, Merry Christmas and thank
you Tex for giving the gift of PCLinuxOS.
You have created the absolute best
Linux ever. I'm very proud to contribute
to PCLinuxOS and to be a part of this
community. parnote
What I will definitely stick with is
PCLinuxOS. There's nothing better.
lockwoodlo
I'm also thankful for the PCLinuxOS
community. A better bunch of folks you
won't find anywhere. horusfalcon
My LXDE custom mini on sda runs
better than Windows ever did. Ferdes
Fides
PCLinuxOS has the best support I have
ever seen! PCLinuxOS user forums are
the most relevant, enthusiastic,
knowledgeable, helpful and friendly
communities I have seen. alex
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How To Use PCLinuxOS As A Router
by muungwana

the computer to access the internet, or to access the
local network the primary interface is connected to.

A router is a device that connects two or more
networks.

Before we continue, it is important to (re) familiarize
ourselves with network terminologies.

A computer needs three things to be able to act as a
router. It needs at least two network interfaces, with
each interface connected to a network. It needs to
be configured to allow traffic to pass from one
interface to another. Finally, it needs to be
configured to masquerade traffic from the secondary
interface as it leaves the primary interface.

An IPv4 address is made up of 32 bits, ie 32 ones
and zeros. It is also made up of two parts, a network
address and a host address. An IP address is
usually represented as a decimal number
representation of these 32 bits broken down to four
chunks, each chunk consisting of eight bits and
separated by a dot character.

The primary interface is an interface that is
connected to a larger network. The larger network
maybe the internet at large, or it can be a local
network connected to the ISP network. The primary
interface is the interface that connects the computer
to the internet.

An IPv4 address looks like: 192.168.10.10. The “dot”
is added for clarity, and is not part of the binary
representation. It just marks the eight bit boundary.

They both say the same thing. Of the 32 bits of an
IPv4 address, the first 24 bits are used to represent
a network address, and the remaining eight bits are
used to represent a host address, an address of a
network device within its network.
What distinguishes one network from another is the
network address, identified by a netmask address.
All computers that have the same network address
belong to the same network, and must send their
traffic to a router when they want to communicate
with other computers that are in another network.

”192” for example is a decimal representation of a
binary number “11000000”.
“192.168.10.10” is an IPv4 address and its binary
equivalent is
“11000000 10101000 00001010 00001010”
A netmask has the same number of bits and format
of IPv4 address and it is a variable that is used to
separate a network address from a host address in
an IPv4 address.
A netmark address of 255.255.255.0 corresponds to
“11111111 11111111 11111111 00000000” binary
address.
An IPv4 address given as:
IP address : 192.168.10.10
netmask
: 255.255.255.0

The secondary interface is the interface that is
connected to a network which acts as a bridge for
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which is equivalent to 192.168.10.10/24

It is not allowed for network traffic belonging to one
network to be seen outside of its network, and any
traffic that somehow manages to “escape” its
network simply gets dropped. The router's
responsibility is to sit on network boundaries and
“masquerade” network addresses of traffic from one
network as it crosses network boundaries, and to
allow the traffic to pass through safely.
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A gateway address is an address belonging to a
router, and it acts as a gateway in and out of a
network.
A typical network properties listing of an interface
may look something like this:
IPv4 address
netmask
gateway
DNS

The above says:

:
:
:
:

192.168.10.10
255.255.255.0
192.168.10.1
8.8.8.8

The host address is 10, the host address belongs to
a network with a network address of 192.168.10.0,
the first 24 bits of the 32 bit IPv4 address are used
to represent a network address, and the “door” in
and out of this network is at 192.168.10.1. The
router is at this address. The DNS address is not
relevant to this discussion.
For simplicity, we will call the computer that will act
as a router “alice” and a computer that will access
the internet through “alice” computer “bob.”
Before we continue, make sure “alice” and “bob” are
connected, either through a hub or through a

crossover cable, if a cable runs directly from one to
the other. Modern network interfaces can handle
direct connections of interfaces with normal cables
and it may not be necessary to use a crossover
cable with direct connections. It is also possible to
connect them wirelessly using wireless network
interfaces.
Also, make sure “alice” can go online through the
primary interface.
For a computer to act as a router, it needs more than
one interface. Traffic needs to be allowed to flow
from one interface to another. Lastly, traffic from the
secondary interface must be masqueraded when
passing through the primary interface network.
A kernel option that allow traffic to pass from one
interface to another is at:
“ /proc/sys/net/ipv4/ip_forward”.
Traffic is not allowed to flow between interfaces if the
content of the virtual file is “0,” and traffic is allowed
if the content is “1”.

Once again, in a terminal session on “alice,” (as
root) run the following command (all on one line):
/sbin/iptables t nat
o XYZ j MASQUERADE

I

POSTROUTING

XYZ is the primary interface (eth0, wlan0, etc.).
The above rule says the following:
Insert a “masquerade” iptable rule in the
“postrouting” chain of a “nat” table. Iptables rules are
hierarchical. Tables are at the top, chains follow, and
lastly rules. The “postrouting” chain acts on all traffic
just before it leaves the network, and the
“masquerade” says “change the network address of
whatever traffic is passing through to the network
address of this interface.”
If you want the rule to survive reboots, from the
terminal, as root, run “service iptables save.” Then,
go to PCC (PCLinuxOS Control Center) services
section, and make sure “iptables” is set to start at
boot time.

To set the option to “1”, run the following command
(as the root user) from a terminal session on “alice.”
echo 1 > /proc/sys/net/ipv4/ip_forward

If you want the option to survive a reboot, add
“net.ipv4.ip_forward = 1” to the “/etc/sysctl.conf”
configuration file. First, make sure the line is not
there before you add it. If it is already there, but with
an option of “0,” just change the option to “1.” That is
all that is needed to allow traffic to flow from one
network to another.
Now, let’s set up the primary interface
masquerade traffic from a secondary interface.

to

Here we add a rule to iptables. Iptables is a program
in Linux that enforces network traffic policy. Most
Linux firewalls do their business by writing iptables
rules.
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Still on “alice,” resetup the network interface in
PCC’s Network and Internet section, and give the
secondary interface the following network properties:
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IP address : 10.10.10.10
netmask
: 255.255.255.0

That is all. Ignore the dialog if it shows you an error
warning.
Give the network interface on “bob” that is
connected to the secondary interface on “alice” the
following network properties:
IP address
netmask
gateway
DNS

:
:
:
:

10.10.10.20
255.255.255.0
10.10.10.10
8.8.8.8

The place where breaking news,
BitTorrent and copyright collide

Screenshot
Screenshot Showcase
Showcase

That is all. ”bob” should now be able to go online
using “alice” as its router, i.e., as its gateway.
The host address of the network interface on “bob”
is “20.” Its network address is 10.10.10.x.
The host address of the secondary interface on
“alice” is “10.” Its network address is 10.10.10.x.
The above means the two interfaces belong to the
same network.
The primary interface on “alice” will have/should
have a different network address, making it belong
to a different network. The two commands executed
above connect the two interfaces, and allow traffic to
pass between them, which makes “alice” a router.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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Posted by smileeb, January 5, 2013, running KDE4.
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How To Create, Edit ePub Files In Sigil
by stealth
So what is Sigil? It is a fancy data compression app.
You can use it to open existing ebook files and edit
them, or you can use it to create your own new
ebook files.
What are ePub files? Are they a mystery to you?
Ever wonder how they are created? The ePub files
don't have to be a mystery, and you are about to
learn how to create them. ePub files are, in essence,
a self contained portable website with some
improved features.

Three Editing Modes In Sigil
The image below shows you the Sigil Editor in the
center section of the combination mode where you
do the editing in WYSIWYG or the HTML code. The
single tool icon on the toolbar (below the Tools menu
circled in red) is how you get to the combination
editor from the toolbar. You can see which file you
are working in by the green highlight in the left Book
Browser Window, as well as the tab above the
editing window. The TOC for the book can be viewed
in the Table of Contents window to the right. The two
icons circled in red are the Metadata editor on the
left and the TOC generation on the right.

The two files circled in the Book Browser in the left
section of the image below are key files, which are in
any ePub file. The toc.ncx is where the TOC, which
you can see in the pane on the right, is stored. The
content.opf stores the list of the entire contents of
the ePub file. The content.opf file is also what
controls the order the HTML files will be arranged in
for viewing in an ebook reader.

An Overview Of Sigil
If you just want to edit an existing ePub file or create
one, and you don't care how it is put together or how
it works, then use Sigil. It takes care of all the
technical stuff for you and makes everything work
correctly. However, Sigil does not appear to provide
access to all of the features made available in the
ePub standard as found at idpf.org. Sigil does have
a slick Table of Contents (TOC) creation feature.
Sigil In Linux, Mac and Windows
There does seem to be some lost functionality when
using Sigil in Linux. Windows and Mac users claim
the ability to do things that just don't seem to work in
the Linux version. Even the documentation says
certain things can be done, but they don't work for
Linux users. You can still use the app to create and
edit ePub files. Just apparently not with the same
ease that Windows and Mac users have. Your
mileage may vary.
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You can see Full Code editing in this image, below.
The toolbar icon for this mode is circled in red.

You can see full WYSIWYG editing in this image,
below. The toolbar icon for this mode is circled in
red.

It is also how you will see them in the Book Browser
under the Text folder (above) in the pane on the left.
All your HTML, SVG/PNG/JPG/GIF, CSS, fonts,
audio, video and possible script files, such as

Page 27

How To Create, Edit ePub Files In Sigil
JavaScript, are contained in the same folder in the
ePub file. But, they can also be contained in sub
folders, as you can see above on the left. Those
folders are actually created, and the files are
separated into them by Sigil when you open an
existing ePub file, or when you create a new one.
The ePub standard from idpf.org suggests that they
all be stored in the same file and not separated,
although it is allowed. I’m not sure why the author of
Sigil decided to go the route which is not suggested,
but allowed. Maybe he is following Microsoft's lead
of not following standards. The reason they suggest
not doing it this way, as seen above, is because
there is nothing in the standard requiring a reader to
follow the linking behavior which is required for the
separated folder setup to work. Doing it that way
might work in one reader, but not in another. The
linking behavior is identical to what you might do
with a web site, but it is not required of the reader to
handle the links or the folder structure properly. All
the readers I have tried handle the links properly.
From within Sigil, you cannot see the upper folders
or the other two essential files that are required in
any ePub file. Those two folders and two files are
identical in every ePub file, and it won't work if they
aren't.
In the image above, you see the folders with little >
pointers next to some of the folders. That means
there are files in those folders, and none in the
others lacking the > pointers. You will see, farther
down, that those folders don't actually exist in ePub
files generated by publishers. However, if you used
Sigil to open and edit an existing file, then saved it,
Sigil will create the folders and restructure all the
files in that ePub file. Sigil will also correct any
linking problems caused by the restructure.
Sigil's TOC Generation
Below is the automatic TOC generation feature
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I mentioned above. You will also see the search tool
at the bottom of the editing window. The icon with
the magnifying glass on it, just to the left of the Tools
drop down menu in the image, is how you open,
search and replace from the toolbar.

You can also do the TOC by hand if you want. You
can also edit part of it after automatic generation. If
you do edit the file after it is created, you will see
activity in the right pane as you are editing.

Creating An ePub From Scratch

Here is what the same file that is in the previous
images looks like from within Ark (above). For some
reason, Sigil replaces that callouts folder in this
ePub. It is at the same level as the sub folders you
saw in the Sigil images above. It has some *.gif files
in it. You can see a couple of different file types,
including HTML and OTF (OpenType Font) files. You
will also notice that the subfolders that you saw in
Sigil aren't here, because they don't actually exist in
this ePub file. O'Reilly makes all their ePub files with
all the content files in the same folder, with the
exception of that callouts folder with the *.gif files in
this ePub.

Right Click Context Menus
There are right click context menus almost
everywhere in Sigil. Right clicking on the text folder
will let you start a new HTML file, or import existing
files. Any existing files have to be well formed by the
XHTML 1.1 standard, or Sigil will not bring them in.

The image below shows more file types, including
the content.opf, CSS and image files.
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You can see the toc.ncx file at the bottom of the
window in the image below (next page, top left).

Create Your Own ePub File From Scratch
I prefer to do it this way. It lets me be in control,
instead of an application. The current standard for
ePub is EPUB3. It supersedes the older EPUB2
specification.
Open a file manager and create the folder and name
for your ePub file name. Then create your two sub
folders METAINF and OEBPS.

In the image below, you can see the two essential
subfolders and the two essential files I mentioned
above, which you cannot see when opening the
ePub file in Sigil. The OEBPS (Open eBook
Publication Structure) folder is where all the content
files for the ebook are stored. That also includes the
content.opf and toc.ncx. The contents of the OEBPS
folder is all you see in Sigil. The OEBPS folder and
the METAINF folder are one level down from the
main folder and one level up from the contents you
see in the Sigil images above, or what is actually the
ePub file that you would open and read in an ebook
reader.
How Does An ePub File Go Together?
If you are like me and have to find out how the ePub
file works, or what the full process for making a
properly working ePub file is, then you will have to
roll up your sleeves and get ready to get all that
technical stuff all over you. Just kidding! I sure am
glad it is not like working on a gasoline engine.
You need to know how to use a compression app
like ark, xarchiver, Q7Z, p7zip, fileroller, tar or zip. If
you know how to create folders on your computer,
and you know how to use a text editor, then you can
create your own ePub file using your favorite text
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editor and compression app. My favorite text editor
is Vim, of course. Oh, you will also have to know a
little something about making well formed HTML,
XHTML and XML files.
The container.xml & mimetype
So what is the container.xml file and the mimetype
file? The container.xml file is, as the name implies, a
container file which references the content.opf file
found in the OEBPS folder inside the ePub file. An
example is shown below.
<?xml version="1.0" encoding="UTF8"?>
<container version="1.0"
xmlns="urn:oasis:names:tc:opendocument
:xmlns:container">
<rootfiles>
<rootfile full
path="OEBPS/content.opf" media
type="application/oebpspackage+xml"/>
</rootfiles>
</container>
The mimetype file contains only what you see below.
The ePub file is a zip file.
application/epub+zip

Here is the structure of the ePub file as viewed in
Ark before extraction.

Here is the structure of the ePub folder after
extraction.

Epub file name
|
|____METAINF (1 Required)(Other
Files Optional)
|
|
|
|____container.xml (1
Required)
|
|____OEBPS (1 Required)
|
|
|
|____HTML/XHTML (1
Required)
|
|
|
|____CSS (Optional)
|
|
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|
|____SVG/PNG/JPG/GIF
(Optional)
|
|
|
|____scripts (Optional)
|
|
|
|____videos (Optional)
|
|
|
|____audio (Optional)
|
|
|
|____fonts (Optional)
|
|
|
|____content.opf (1
Required)
|
|
|
|____toc.ncx (1 Required)
|
|____mimetype (1 Required)
Creating The Required Files In The ePub
Start your favorite text editor, and enter the
following:
application/epub+zip
Save this file in the root folder that has the ePub file
name, and name this file mimetype. Do not put the
mimetype file in OEBPS or METAINF. It has to be at
the same level they are.
Start a new file and add exactly what you see here
for the container.xml file. Then save that to the
METAINF folder.
<?xml version="1.0" encoding="UTF8"?>
<container version="1.0"
xmlns="urn:oasis:names:tc:opendocument
:xmlns:container">
<rootfiles>
<rootfile full
path="OEBPS/content.opf" media
type="application/oebpspackage+xml"/>
</rootfiles>
</container>
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The toc.ncx File
Below is a sample of a toc.ncx file. Creating this
from scratch can be a hassle. This is an XML version
of the HTML list. It is an XML file with opening and
closing NCX tags and the XML Namespace in the
opening NCX tag. It can be used with or without a
DOCTYPE declaration in the file. I have found that,
sometimes, NOT using a DOCTYPE allows you to
create a TOC that would otherwise not work. The
sample toc.ncx below has three sections between
the NCX tags: head, docTitle and navMap. The
standard at idpf.org says you can also have two
other sections called navPage and navList. Each
section is separate from the others, and each has its
own opening and closing tags. I cut out most of the
middle of this toc.ncx file because it was too long.
Within the navMap section you will find:
<navPoint>
<navLabel>
<text>Your TOC Text</text>
</navLabel>
<content src="yourfile.html"/>
</navPoint>
You can nest the navPoint element like so.
<navPoint>
<navLabel>
<text>Your TOC Text</text>
</navLabel>
<content src="yourfile.html"/>
<navPoint>
<navLabel>
<text>Your TOC Text</text>
</navLabel>
<content src="yourfile.html"/>
</navPoint>
</navPoint>
Here is a sample DOCTYPE
<!DOCTYPE ncx PUBLIC "//NISO//DTD ncx
20051//EN"

"http://www.daisy.org/z3986/2005/ncx
20051.dtd">
This sample toc.ncx does NOT have a DOCTYPE
declaration. If it did, it would go between the XML
tag and the NCX tag, in basically the same manner
as your XHTML files. Also, the XML tag below,
starting with <?xml..., has standalone="no" included.
This does not have to be there. Additionally, because
the toc.ncx does NOT have a DOCTYPE listed, the
playOrder attribute in the navPoint element does not
have to be there. It is required if the DOCTYPE that
covers it is declared in the file. The inclusion of the
playOrder would imply that the playOrder can be out
of order 1, 3, 2 etc. instead of 1, 2, 3. I have never
seen that. I have also have never tried it. I do know
you can skip 1, 3, 4 etc. I have done this in the
process of creating and testing as I went.
<?xml version="1.0" encoding="UTF8"
standalone="no" ?><ncx
xmlns="http://www.daisy.org/z3986/2005
/ncx/" version="20051">
<head>
<meta content="cover"
name="cover"/>
<meta content="isbn:9780596159351"
name="dtb:uid"/>
<meta content="1"
name="dtb:depth"/>
<meta content="0"
name="dtb:totalPageCount"/>
<meta content="0"
name="dtb:maxPageNumber"/>
</head>
<docTitle>
<text>Learning the vi and Vim
Editors</text>
</docTitle>
<navMap>
<navPoint id="id2909437"
playOrder="1">
<navLabel>
<text>Learning the vi and Vim
Editors</text>
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</navLabel>
<content src="Text/index.html"/>
<navPoint id="id2857362"
playOrder="2">
<navLabel>
<text>Preface</text>
</navLabel>
<content
src="Text/pr01.html"/>
<navPoint id="id2857202"
playOrder="3">
<navLabel>
<text>Scope of This
Book</text>
</navLabel>
<content
src="Text/pr01.html#vi7ch0sect1"/>
</navPoint>
<navPoint id="id3103816"
playOrder="4">
<navLabel>
<text>How the Material Is
Presented</text>
</navLabel>
<content
src="Text/pr01s02.html"/>
<navPoint id="id3168839"
playOrder="5">
<navLabel>
<text>Discussion of vi
Commands</text>
</navLabel>
<content
src="Text/pr01s02.html#vi7ch0sect
2.1"/>
</navPoint>
<navPoint id="id3174260"
playOrder="6">
<navLabel>
<text>Conventions</text>
</navLabel>
<content
src="Text/pr01s02.html#vi7ch0sect
2.2"/>
</navPoint>
<navPoint id="id2856537"
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playOrder="7">
<navLabel>
<text>Keystrokes</text>
</navLabel>
<content
src="Text/pr01s02.html#vi7ch0sect
2.3"/>
</navPoint>
</navPoint>
</navPoint>
</navMap>
</ncx>
The content.opf File
Shown below is an example of a content.opf file. I
cut out most of this one, too, because of length. The
content.opf file has an opening and closing
PACKAGE tag with an XML namespace in the
opening tag. It has four sections between the
PACKAGE tags, each separate from the other, and
each with its own opening and closing tags:
METADATA, MANIFEST, SPINE and GUIDE.
METADATA: Contains information about you and
your book. dc:indentifier, dc:title, dc:language and
meta are the only required elements in this section.
MANIFEST: All of your book content must be listed
here.
SPINE: This must have all of the book content,
minus images, CSS, audio, video, fonts and any
scripts. The order in which the content is listed is the
order in which the content is presented in a reader.
GUIDE: Can be empty. The section must be in the
file, though.
<?xml version="1.0" encoding="utf8"
standalone="no"?>
<package
xmlns="http://www.idpf.org/2007/opf"
version="2.0" unique

identifier="bookid">
<metadata>
<dc:identifier
xmlns:dc="http://purl.org/dc/elements/
1.1/"
id="bookid">urn:isbn:9780596159351</dc
:identifier>
<dc:title
xmlns:dc="http://purl.org/dc/elements/
1.1/">Learning the vi and Vim
Editors</dc:title>
<dc:rights
xmlns:dc="http://purl.org/dc/elements/
1.1/">Copyright © 2009 Arnold Robbins
and Elbert Hannah</dc:rights>
<dc:publisher
xmlns:dc="http://purl.org/dc/elements/
1.1/">O'Reilly Media</dc:publisher>
<dc:subject
xmlns:dc="http://purl.org/dc/elements/
1.1/">COMPUTERS / Operating Systems /
UNIX</dc:subject>
<dc:date
xmlns:dc="http://purl.org/dc/elements/
1.1/">20090630</dc:date>
<dc:description
xmlns:dc="http://purl.org/dc/elements/
1.1/">&lt;p&gt;The standard guide for
&lt;em&gt;vi&lt;/em&gt; since 1986,
this book has been expanded to include
detailed information on
&lt;em&gt;vim&lt;/em&gt;, the leading
&lt;em&gt;vi&lt;/em&gt; clone that
includes extra features for both
beginners and power users. You learn
text editing basics and advanced tools
for both editors, such as writing
macros and scripts to extend the
editor, power tools for programmers,
multiwindow editing  all in the
easytofollow style that has made
this book a
classic.&lt;/p&gt;</dc:description>
<dc:creator
xmlns:dc="http://purl.org/dc/elements/
1.1/"
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xmlns:opf="http://www.idpf.org/2007/op
f" opf:fileas="Arnold Robbins">Arnold
Robbins</dc:creator>
<dc:creator
xmlns:dc="http://purl.org/dc/elements/
1.1/"
xmlns:opf="http://www.idpf.org/2007/op
f" opf:fileas="Elbert Hannah">Elbert
Hannah</dc:creator>
<dc:creator
xmlns:dc="http://purl.org/dc/elements/
1.1/"
xmlns:opf="http://www.idpf.org/2007/op
f" opf:fileas="Linda Lamb">Linda
Lamb</dc:creator>
<dc:language
xmlns:dc="http://purl.org/dc/elements/
1.1/">en</dc:language>
<meta name="cover" content="cover
image"/>
</metadata>
<manifest>
<item id="ncxtoc" media
type="application/xdtbncx+xml"
href="toc.ncx"/>
<item mediatype="text/css"
id="css" href="core.css"/>
<item id="cover" href="cover.html"
mediatype="application/xhtml+xml"/>
<item id="epub.embedded.font.1"
href="LiberationMonoBold.otf" media
type="font/opentype"/>
<item id="epub.embedded.font.2"
href="LiberationMonoBoldItalic.otf"
mediatype="font/opentype"/>
<item id="epub.embedded.font.3"
href="LiberationMonoItalic.otf"
mediatype="font/opentype"/>
<item id="epub.embedded.font.4"
href="LiberationMono.otf" media
type="font/opentype"/>
<item id="epub.embedded.font.5"
href="LiberationSerif.otf" media
type="font/opentype"/>
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<item id="id2909437"
href="index.html" media
type="application/xhtml+xml"/>
<item id="coverimage"
href="httpatomoreillycomsourceoreillyi
mages8936.jpg" media
type="image/jpeg"/>
<item id="id3093658"
href="oreilly_large.gif" media
type="image/gif"/>
<item id="id2857362"
href="pr01.html" media
type="application/xhtml+xml"/>
<item id="id3175607"
href="pt01.html" media
type="application/xhtml+xml"/>
<item id="id3175744"
href="ch01.html" media
type="application/xhtml+xml"/>
<item id="id3176055"
href="httpatomoreillycomsourceoreillyi
mages8938.png" media
type="image/png"/>
<item id="id3346907"
href="author_bios.html" media
type="application/xhtml+xml"/>
<item id="id3130574callout1"
href="callouts/1.png" media
type="image/png"/>
<item id="id3130574callout15"
href="callouts/15.png" media
type="image/png"/>
</manifest>
<spine toc="ncxtoc">
<itemref idref="cover"
linear="no"/>
<itemref idref="id2909437"/>
<itemref idref="id3103816"/>
<itemref idref="id3346923"/>
</spine>
<guide>
<reference href="cover.html"
type="cover" title="Cover"/>
</guide>
</package>

Your ePub Content
Create or copy all the XHTML, images, CSS, Fonts,
(EPUB3 won't need the font files, but includes
provisions for them), and any other files that are
necessary for the book, and save those in the
OEBPS folder. You can save them into organized
sub folders under the OEBPS folder, if you want.
Make sure your XHTML and CSS files validate
correctly with the validation tools on the W3C
website. That step is absolutely essential.
Otherwise, your ePub WILL NOT work if you don't
have well formed documents. You can also validate
your ePub files at several web sites.
It is best to leave out any code that you would use to
create your structural look and layout. Just use
content markup, h1h6, p, em, strong, ul, ol, li, dl, dt,
dd, table, tr, th, td, div, blockquote tags, and some
others I am probably missing, and use CSS for all
your styling. Stay away from position and size in
your CSS. Don't use layout controls because it will
cause problems in the ePub file, even if the HTML
validates on W3C. Those controls disrupt a large
part of what the ePub reader is designed to do on its
own. Your HTML/XHTML files need to have the
DOCTYPE, as shown below, in the HTML/XHTML
files you use in your ePub:
<?xml version="1.0" encoding="UTF8"?>
<!DOCTYPE html PUBLIC "//W3C//DTD
XHTML 1.1//EN"
"http://www.w3.org/TR/xhtml11/DTD/xhtm
l11.dtd">
Your HTML/XHTML files can contain internal
hyperlinks to enable moving around in the book, and
even external hyperlinks to leave the book. (That is
also dependent on the reader you are using, and the
device). You can have an HTML menu file at the
beginning of the book, with standard HTML
hyperlinks directing to the contents of the book. You
can also have the toc.nxc, which is not actually part
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of the book content, where the HTML menu would
be. See idpf.org for exact specification of the
conformance of your XHTML documents.

Epub Authority

I know my HTML files with the above DOCTYPE,
saved as .html, have worked so far. It looks as
though the xhtml extension is required with EPUB3.
So, I have renamed all my files to .xhtml in the
ePubs I have created. My ePub files still work with
the new file names inside. I had to edit a lot of
hyperlinks. Creating new files for your ePub in Sigil
will create them as .xhtml.

The governing authority on ePub is idpf.org. There is
a lot of cool technology that is available for ePub
files. But, there is also a problem with the technology
not being used fully by the different ePub readers. I
know on our PCLinuxOS distribution, the best ebook
readers I have found so far are the ebook viewer
that comes with Calibre, and fbreader. I wouldn't
waste my time with any of the others. Okular will
read ePub files, but it won't display them, probably
because it doesn't have the dynamic flow capability
of the actual ebook readers. There are also a couple
of freely available epub reader addons for Firefox.
One is called EPUBReader, and the other one is
called Lucifox.

Testing Your New ePub

You Have Enough To Get Started

Once you are finished creating the ePub content,
clean up any back up files and any other
unnecessary files in the OEBPS folder. Then open a
compression application and zip the main folder and
everything in it. Next, rename the extension of the
new zip file, changing it from zip to epub. Finally, try
opening the file in your favorite ebook reader. If you
did everything correctly, you will be able to read your
new file. If you didn't do it correctly, go back to the
main folder that you started from. Check everything,
making sure you have all the required files and
folders in the correct locations, and they are named
correctly. Check to see if the contents inside those
essential files are typed correctly. Once you are sure
everything is right, just delete the old ePub file and
save a newly compressed zip file. Change it again
from zip to epub, and try opening it again. If you can
make a set of HTML files work correctly on a
website, you should also be able to make your ePub
files work. Be sure you have all the essential files
and folders in your ePub, and they are named
correctly and in the correct locations.

I gave you enough information to create well formed
and properly working ePub files that you can roll with
just a text editor and a compression app. You can
learn a lot more by going to idpf.org and reading the
documentation, if you want to learn about ePub file
creation in greater detail. That is what I did,
particularly after I was asked to write this article. I
am still going there to learn more to use as a
reference. EPUB3 will have a lot of improvement
over EPUB2. So, that is reason enough to visit
idpf.org often.

EPUB2 supports CSS2 and up with limited support
for CSS3, (EPUB3 supports more of CSS3), HTML5,
XHTML 1.1, XML 1.0, SVG 1.1.
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Although they don't require it, I am adding the
acknowledgment information for the very small part
of the ePub file I used for my examples.
Learning the vi and Vim Editors
Arnold Robbins, Elbert Hannah, Linda Lamb
Copyright © 2009 Arnold Robbins and Elbert
Hannah
O'Reilly Media
1005 Gravenstein Highway North
Sebastopol, CA 95472
8009989938 (in the United States or Canada)
7078290515 (international or local)
7078290104 (fax)
http://www.oreilly.com
Thank you O'Reilly Media for your contribution and
friendly position towards the Open Source
Community. Additionally, thanks for making your
publications so easily accessible for life, and in so
many formats. Also, a big thanks for making them
DRM free!
Happy ePub rolling!

Credit And Thanks
The same ePub file was used in all the examples,
both in the images and some of the copy and paste
code examples. That ePub was purchased by me
from O'Reilly Media. And falls within O'Reilly Media's
automatic permissions, which allow the use of part of
their work found in nearly every one of their
publications.
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International Community
PCLinuxOS Sites

Netherlands

Visit Us On IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclosmag"
(without the quotes)

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Screenshot
Screenshot Showcase
Showcase

Turkey
Denmark

Czechoslovakia

Italy

Poland

Brazil
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Posted by µT6, January 6, 2013, running KDE4.
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Game Zone: Killing Floor
by daiashi

But, in the typical way these things go, the program
didn’t want to be shut down. The specimens got
loose. No one was left alive to turn off the specimen
cloning equipment. Now, they are running amok.
Well, some of them are running amok. Others are
shambling amok or even jumping amok, but you get
the idea.

These are the minimum requirements for Windows
7/Vista/XP. However, I have always had better luck
when these specs are slightly higher, on account of
playing through WINE.

The police were sent in, but that wasn’t even a
challenge for the specimens. The first army units
hadn’t been warned what to expect. The screams of
“It’s got a bloody chainsaw!” over the radios probably
didn’t do much for morale, as whole units were
chewed up. Quite literally, in some cases, of course.

Based in Roswell, Georgia, Tripwire Interactive is an
entertainment software developer and publisher
founded in 2005 by the awardwinning mod team
and winners of the 2004 edition of the “$1,000,000
Make Something Unreal” competition. The team
released Red Orchestra: Ostfront 4145, to both
critical and commercial success, garnering several
awards including “Multiplayer Game of the Year” and
“FPS of the Year”. This was followed by the
immensely popular Killing Floor, which went straight
to the top of the bestseller list on Steam and has
now sold over 1.2m units, making it one of the best
selling PC games of all time. Red Orchestra 2 was
released in September 2011, to high praise and PC
Gamer’s award for “FPS of the Year (Multiplayer)”.
Along with publishing other Indie titles, Tripwire
Interactive continues to build a reputation for strong
support for all their titles over a prolonged period of
time.

Now, there is just you. And a few friends. There are
also a few survivors from the first police and army
units thrown in. Of course, you can’t tell anyone
anything, because that would be a breach of the
Official Secrets Act 1911, 1920, 1989. That would be
a disciplinary offense. So just get in there and do
your bit for Queen and Country.
About The Game
Killing Floor is a coop survival horror game. Up to 6
players can play in online coop mode, or just you,
on your own, playing in the Solo mode. The aim –
cleanse each area of zombies, in waves, until you
get to the last one. The Big One. The Patriarch.
Then, exterminate him, too. Actually, they aren’t
“zombies” at all. They are the leftover “specimens”
from a cheap and dirty government program to clone
monster soldiers. The basic ones will just munch on
your arm and try to disembowel you. The bigger
ones were the first ones they tried arming. Nothing
much. Just a chainsaw or a blade for starters. They
had just caught on to the chain gun and rockets
when the government tried to shut down their secret
program.
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Zombies. Lots of them. Big ones, little ones. Armed
and Dangerous. JUST MAKE THEM ALL GO AWAY!
http://killingfloorthegame.com/
System requirements
Software: Wine and steam.

About The Company, Tripwire Interactive

Some Gameplay Screenshots

Hardware:
Processor: 2.4 GHz
Memory: 2 GB
Graphics: 128 MB Directx 9.0c compatible or better
with pixelshader 2.0
Hard Drive Space: 2 GB
Sound: Directx Eax compatible.
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Game Zone: Killing Floor

Disclaimer

Getting It To Run
Ok, first things first. Head on over and grab Steam.
WINE should install it without any problems, as the
WINE team has made lots of progress from where
they used to be. Once you have Steam up and
running, type “killing floors” in the search bar within
Steam to quickly locate it. It started up with no
problems with a fully updated PcLinuxOs. There was
a slight freeze occasionally and stuttering, however
these settings seem to work best. Others may vary.
You can play around with it to see what works best.
The only issue I had was after closing the game, you
were left with the game’s resolution. If you are able
to play at your desktop’s setting, you should not
have this problem. Otherwise, you can enter (xrandr
s 0) in a console without the parentheses. I wanted
to go ahead and enter this, knowing that Tripwire’s
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titles have been sent to steam under Linux, but it
has not been released to the masses as of yet. Well,
I hope you enjoy it.

1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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ms_meme's Nook: Goody, Goody

Oh I left that Windows

I lie awake

And now I'm kicking up my heels

Just thinking about it all

If you do it too

And now I've got a brand new install

Goody Goody

I've no longer got the bizarre

Goody Goody

You'll like just how it feels

Goody Goody

Hooray for Texstar

I'm no longer blue

Goody Goody for Linux

The same will happen to you

Goody Goody for the best

My 'puter's no longer in pieces
Now how do you do
MP3
PCLinuxOS Magazine

Goody Goody for PCLOS

ms_meme

OGG
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Something Old, Something New
by Patrick G Horneker (phorneker)
The past three months brought a lot to the Linux
world, namely some new distributions, new tablet
and smartphone operating systems (all built on the
Linux kernel), giving some real competition to
Android (and to iOS and Windows Phone).
Thankfully, the world did not end on December 21st
as some predicted. However, the world of Windows
did end in October … with the introduction of
Windows 8.
The latter event did have some profound changes to
the world of Linux, namely for new machines that
incorporate the UEFI specification, and what needs
to be done to new machines to be able to install
PCLinuxOS. This means that in order to install
PCLinuxOS, the user would have to take the extra
step to disable UEFI before attempting to boot
PCLinuxOS. Alternately, we would have to include a
bootloader
program
such
as
Shim
(http://mjg59.dreamwidth.org/20303.html) as well as
GRUB 2 on the ISO image.

Predictions for 2013
The following are my predictions for PCLinuxOS for
2013:
Anything specific to GNOME 3 will be removed from
the repositories, and replaced with equivalents from
the Gnome Legacy project, effectively continuing
support for GNOME 2.

A new desktop theme will be implemented for 2013.

Cinnamon and MATE will be implemented as
desktops and included in the repos in separate
directories, not unlike what we do with KDE and
Xfce as desktops.

A number of new distributions have appeared on the
Linux scene, many of which are targeted towards
older hardware. What is common to these is the use
of Enlightenment, MATE and GNOME 2 for default
desktops. (Thankfully we have kept GNOME 2
around.)

A bootloader such as Shim will be included in the
repository to allow installation of PCLinuxOS on
Windows 8 certified desktops and laptops, getting
around the UEFI problem.
The 64bit version of PCLinuxOS will finally be
released.
MariaDB will replace MySQL in the repositories.
OpenJDK will
repositories.

replace

Oracle

Java

in

the

A version of PCLinuxOS for ARM devices such as
the Raspberry Pi will be implemented. We can
already install PCLinuxOS on memory cards and
USB flash drives, so such an implementation is
possible. However, do not expect a version of
PCLinuxOS to work on smartphones.
New ISOs will be available for direct download in
addition to torrents. However, they will be installable
on blank DVDs, flash drives and memory cards as
the size of their ISO images will be too big to fit on
blank CDs. ISO Images could incorporate more than
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one desktop environment, or could be a variant of
Full Monty with XFCE, LXDE, WindowMaker or E17
instead of KDE, hence making the Full Monty
accessible to older hardware.

What We Need To Do for 2013

So how can we get PCLinuxOS to be an attractive
option for people wanting to migrate from Windows 7
or earlier? Last month’s issue already addressed this
issue when it comes to migration from Windows.
But what exactly makes PCLinuxOS stand out from
other distributions? This is the basis on which my
predictions were derived. These days, Linux in
general is about much more than replacing the Mac
OSX or Windows desktop. Linux appears in most
everything from gaming consoles, to tablets, to
smartphones, to the newest embedded device: The
Raspberry Pi.
We have had some success getting PCLinuxOS
onto desktops and laptops. Otherwise, this
distribution would no longer be around for 2013.
We could work on getting PCLinuxOS onto servers,
not unlike certain major distribution vendors. This
could come in the form of an “enterprise edition”
ISO, or an ISO without a graphical desktop intended
for server installation.
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Something Old, Something New
Or … we could produce an ARM version for devices
such as the Raspberry Pi, which has gained
significant popularity this past year.
64Bit Issues
One thing I have learned about 64bit Linux
distributions is that 32bit binaries will not run on a
64bit distribution without 32bit compatibility libraries
installed. Though many Linux applications can be
compiled for 64bit, there are some applications and
hardware drivers of which there are no 64bit
versions available.

Answers to Mark Szorady's Double Take:

(1) Mound different; (2) Sign posts different; (3)
Snow pile missing; (4) Arm moved; (5) Snowfall
missing; (6) “The” added to sign; (7) Word
balloon different

Screenshot
Screenshot Showcase
Showcase

Fortunately, the 64bit version of Wine in the
PCLinuxOS repository contains a 32bit compatibility
package that allows 32bit Windows binaries to run
on 64bit PCLinuxOS.

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
PCLinuxOS Magazine

Posted by bones113, January 13, 2013, running KDE4.

Page 39

My Screen Is Way Too Dark When Booting
To PCLinuxOS. What Can I Do?

by AndrzejL

6) So, knowing that, let’s try the intel_backlight folder
first (enter all on one line):

So your screen is normally bright, but for whatever
reason when you boot up to PCLinuxOS the
brightness level is very low?

echo n 15 >
/sys/class/backlight/intel_backlight/bright
ness

Try this:
1) Install xbacklight via Synaptic.
2) Open terminal and su to root.
3) List the contents of the folder /sys/class/backlight
with this command:
ls full /sys/class/backlight

4) You should get a few hits:

[root@wishmacer backlight]# ls –full
/sys/class/backlight
total 0
lrwxrwxrwx 1 root root 0 20121104
02:10:05.023004946 +0000 acerwmi >
../../devices/platform/acer
wmi/backlight/acerwmi/
lrwxrwxrwx 1 root root 0 20121104
02:09:09.784000471 +0000 intel_backlight >
../../devices/pci0000:00/0000:00:02.0/drm/c
ard0/card0LVDS1/intel_backlight/
[root@wishmacer backlight]#

5) Now, you need to find the correct command to
use. We are going to push the variable into the
correct folder. The variable and the folder will be
different on all machines, but I think it’s safe to
assume the variable values go from 1 to 15.
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This, however, didn’t go so well.

[root@wishmacer backlight]# echo n 15 >
/sys/class/backlight/intel_backlight/bright
ness
bash: echo: write error: Invalid argument

BINGO! The screen became bright.

8) Now that you know what folder/file to modify, try
changing the variable from 15 to a different value
and see if you get better results with other numbers.
See if you can go to 16 or 14, for example.
9) When your command is ready, open your favorite
text editor as root and modify the /etc/rc.local file by
adding the command as a last line.
10) Save the file and reboot.

[root@wishmacer backlight]#

7) So let’s try the acerwmi folder (again, all on one
line):
echo n 15 > /sys/class/backlight/acer
wmi/brightness

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
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Create A /bin Executable Directory
In Your /home Directory

by Matthew Kelley, via Google+
Reprinted with permission

Here's a Linux tip for the newer users. It’s something
that might make a few things clearer, while making
your system a bit easier to use.

If you don't already have a "bin" folder (and you
don’t, by default, in PCLinuxOS), you can create
one, and then manually add it to your path by editing
your /home/USERNAME/.bashrc file and adding
export PATH=$PATH:$HOME/bin.

Now, there are many different ways to use this folder
and your PATH to your advantage, but I'll give you a
simple usage scenario using the “Run Program”
dialog box that is called with the Alt + F2 command
on most desktop environments.
Lets say you have downloaded a game that isn't in
your
distribution's
repositories.
(Reminder:
PCLinuxOS users are discouraged from installing
applications from outside the official PCLinuxOS
repository). We'll go with the roguelike game "Infra
Arcana," in this instance. Let's assume we unzip the
game
to
/home/USERNAME/applications
/InfraArcana, and that the game's executable is
called "ia."
The first thing we'll do is create a script called ia.sh,
inside the InfraArcana folder. The contents of this
script will be as follows. Of course, you'll have to
change the USERNAME, as necessary:

Some
distributions
give
you
a
/home/USERNAME/bin folder. The idea behind this
folder is that it gives you a place to put executable
scripts. If the folder is preexisting on your distro, it
will almost assuredly be placed in your PATH.
Your PATH, for our purposes, is defined as the listing
of directories that your shell searches for executable
files. In simple terms, it's the difference between
pulling up the terminal and being able to execute a
program by typing in "fu", versus typing
/home/USERNAME/applications/fu_folder/fu.
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#!/bin/bash
cd /home/USERNAME/applications/InfraArcana/
./ia

managers and selecting "Properties" and then
"Permissions" and toggling it to executable.
Alternatively you can bring up the terminal, change
to the game’s directory and issue the command
chmod +x ia.sh.

Now, we can change to the /home/USERNAME/bin
folder in our terminal and create a symbolic link to
this script. You can do this from the command line
with (all on one line):
ln s /home/USERNAME/applications
/InfraArcana/ia.sh infra

What this does is create a symbolic link named
"infra" in the /home/USERNAME/bin folder (similar to
a shortcut on Windows) that points to our script in
the game folder.
At this point, you will find that you can launch the
game by bringing up the terminal and typing in
"infra" and hitting enter. You can also launch other
programs installed by your package manager. Alt
F2, which brings up a "run" dialog on most desktop
environments, will also launch the game with "infra."

exit 0

The script above does two things. It changes the
working directory to the one the game will need, and
it issues the command to start the game.
Next, we'll set the script as executable. You can do
this by right clicking on the script in most file
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LibreOffice 4.0 RC1 Advances Feature Set
by Paul Arnote (parnote)
It doesn’t seem all that long ago that most of us
updated LibreOffice to version 3.6. The Document
Foundation (TDF) isn’t sitting on their laurels,
though. They already have the first release
candidate (RC1) out for LibreOffice 4.0.

Import ink annotations from DOCX and RTF
documents (available when using Word on a Tablet
PC).

LibreOffice is a multiplatform free office suite for
Linux (x86 and x64), Mac (PPC and Intel), and
Windows (x86 only). It is fully read and write
compatible with Microsoft Office files, and uses the
international Open Document format standard.
Here is a rundown of some of the fixes and
enhancements.

Writer
Enable attaching comments to document text
ranges.

Allow different headers and footers on the first page
without using a separate page style.

RTF filter now imports old Drawing Objects syntax.
Import/export
expressions.

support

for

native

RTF

math

Various DOCX improvements: import of floating
tables, OLE objects inside rectangles, margins of
inline images using the WordProcessing markup.
Clicking fields selects them instead of placing the
cursor before them.

Calc
Improved performance of ODS document import.
When opening ODS and XLSX files, the values of
formula can be shown as they were saved in the
files (cached), without recalculating the formula
directly when opening the file. This makes opening
of (larger) files faster. When the spreadsheet was
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last used by someone else, this will always show the
values, as they were on that computer. (It is known
that large, real complex spreadsheets on different
computers, with different OS, processor or software,
can have different results.) So that may be seen as
an advantage when opening spreadsheets that have
last been edited in Excel. The user gets a message
on opening the file. That message can be turned
on/off at "Tools > Option > LibreOffice Calc >
Formula … Recalculation on file load."
Cached value import from ODS and XLSX. Due to
possible different implementations you get a warning
when the cached values are used.
Save settings of Text Import Dialog for Text to
Columns and Paste Unformatted Text from
Clipboard (in addition to Text File Import).
Export color scales and data bars to XLSX (also
supports Excel 2010+ extensions for databars).
Increased size limit on (uncompressed) ODF
documents from 2Gb to 4Gb. (Michael Meeks)
Support "typeahead" search in the autofilter popup.
It is now possible to search for specific entry via key
input.
XML Source dialog to quickly import arbitrary XML
content.

Enhanced chart visualisation  better
rendering/print and PDF export of charts.

quality

Improved accelerated multimedia previews, and
previews of embedded video on Linux.

New conditional formats: Date formats, Top/Bottom
rules, String rules.
Improved conditional format dialogs.
Icon sets.
Overlapping conditional formats.
Initial work on a gnumeric import filter based on
orcus. This is a technical demonstration of the orcus
integration and hidden behind the experimental flag.
Only imports value, strings and formulas in 4.0
(more will follow in the future).
New spreadsheet function XOR as defined in ODF
OpenFormula.
New configuration option to toggle handling of empty
strings when used in arithmetic expression.
Reimplemented RAND() function
random number generation algorithm.

with

Presenter Console RTL support.

better

New spreadsheet functions AVERAGEIF, SUMIFS,
AVERAGEIFS and COUNTIFS as defined in ODF
OpenFormula.
New spreadsheet functions IFERROR and IFNA as
defined in ODF OpenFormula.
Support multiple selections in page field of pivot
table.

Impress
The state of the sidebar pane in Impress is now
remembered.
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Draw
Improve quality of page previews in Draw/Impress
with supersampling.
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Linecap improvements  adding rounded caps
(ends) to lines, see rightclick "Line">"Corner and
Cap Styles."

Session installer: Reduce Java code. Port Fax and
Letter Wizard to Python.

Rounded line caps.

Filters

Shear transforms for GraphicObjects, and shear +
properties for OLE Objects.

Import filter for Microsoft Publisher documents.

Multiimage support in ODF allowing a bitmap +
SVG representation, eg.
Circles and Ovals toolbar from Impress now also
available in Draw.

Base
On all nonWindows platforms a new mork driver
implementation is used to access Thunderbird
address book. This means that Debian/Ubuntu users
can finally integrate LO with their Thunderbird
address book. (Debian/Ubuntu distros are not
shipping a Mozillabased mork driver, therefore their
native Base package can not access the address
book.) This also fixes some really old bugs for
different distros.

Document in Microsoft Publisher

Visio 1.0 released in 1992 to Microsoft Visio 2013
released in 2012.
Improved ODF compatibility in various points.
GUI
New Widget layout technique for dialog windows
introduced, and converted various dialogs. UI
mockups can be created with Glade UI designer
then hooked up to code. Converted widgets can be
edited without recompiling Libreoffice. More easy to
iterate for good UI design. Support for easily resizing
and hiding elements. Reduces code complexity.
Intent to follow bestpractice guidelines for spacing
and indentation yielding nicely spaced, clearer
dialogs.
Added dialog for Smooth image filter, where it is
possible to select the radius (strength) of
smoothing/blurring.

In Forms, AutoFilter no longer treats values as
patterns. As a consequence, an AutoFilter on "A*"
will not match any value starting with an A, but only
the exact value "A*".

Graphics can be resized and recompressed with the
new Compress Graphics.. popup menu function.
Menu function is available is available in Draw,
Impress and Calc but not (yet) Writer. Supports
displaying of current graphics information: original
dimensions, dimensions inside of document. Ability
to reduce image resolution with setting a new
dimension (width/height in pixels and DPI). Lossless
(PNG) or lossy (JPEG) compression with ability to
set the quality and compression strength. Possibility
to select the interpolation (resampling) algorithm.

Core

Added Edit with External Tool to Calc, Impress and
Draw.

CMIS protocol support for easy access to
documents stored on Document Management
Systems like Alfresco, Nuxeo, SharePoint, etc.

Unify Popup menu option Save Graphic… from
Writer and Save as Picture… from Draw and
Impress to Save Graphic….

Integration of session installer to add missing parts
of LibreOffice on the fly.
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Same document in LibreOffice Draw
Extended coverage of Visio fileformat. LibreOffice
4.0.0 supports all existing Visio file formats from

Improve quality of displaying images in documents.
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It is possible now to select and copy text from
message boxes.

Significant load and save time improvements for
slides / drawings with large numbers of shapes.

The "Apply Style" combo box in the toolbar now
features previews of the styles to choose.

Significantly improved RTF file load times.
Linux
Add GStreamer 1.0 support, and refactor existing
gstreamer code.
Extensions
PDF Import, the Presenter Console, and the Python
Scripting Provider are no longer bundled extensions
but core features.
Localization

Hide / Show styles in the “Styles & Formatting”
dialog.

Agenda/fax/letter/report templates localizable via PO
files (File→Wizards).
Added locale data files for axk_CG beq_CG
bkw_CG bvx_CG dde_CG ebo_CG iyx_CG kkw_CG
kng_CG ldi_CG mdw_CG mkw_CG ngz_CG njx_CG
njy_CG puu_CG sdj_CG tek_CG tsa_CG tyx_CG
vif_CG xku_CG yom_CG.
Autocorrection improvements for ptBR.
The LightProof grammar checker for Brazilian
Portuguese is now avaiable. Improvements in ptBR
spell checking.
Performance

Support Firefox Personas in LibreOffice. With
LibreOffice 4.0, you can choose Tools > Options...
> Personalization > Select Persona, choose a
persona you like in your browser, paste its address
to the dialog, confirm, and LibreOffice will use that.
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Improved ODS load times.
Improved XLSX load time.
Significantly improved the performance of saving a
new entry to a large autocorrect replacement table.

Feature removal / deprecation
Dropped support for legacy binary StarOffice
(version 1.x → 5.x) files. Note that the old
OpenOffice.org XML file format (.sxw, .sxi etc.) which
was used as the default format by StarOffice
versions 6 and 7 is still supported.
Dropped support for export to legacy Word and
Excel (version 6.0/95) files. These files can still be
opened, but they will save in your default format
(usually .odt/.ods). We continue to export to the
Office 97 and later binary file formats of course. This
avoids user confusion, and accidentally selecting
very old formats that will lose document data.
Dropped support for ODMA document management
integration, this windowsspecific integration point is
deep legacy, and yields some horrible user
interactions.
Dropped legacy STLport library for compatibility with
old extensions that linked against it (was only
included for 32bit Linux and Windows).
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LibreOffice 4.0 RC1 Advances Feature Set
Deprecated Mac/PPC as a platform, raising our
baseline to 10.6.
Summary
There you have it. These are most of the changes
that most users will see and appreciate. There are
other changes, beneath the hood. You can see the
full feature list here. As you can see, The Document
Foundation continues to work on and improve
LibreOffice. Accordingly, LibreOffice continues to
grow and become an even more featurerich office
suite – as if it wasn’t already. Without the weight and
burden of a large corporation (e.g., Sun and Oracle),
LibreOffice’s progress seems to have outpaced that
of its corporate origins. Clearly, the development
team at The Document Foundation is nimble and
quick, responding rapidly to everchanging needs of
its users.

Screenshot
Screenshot Showcase
Showcase

Posted by ferry_th, January 12, 2013, running Openbox.
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Five New Testimonials
from besonian

painfully around in order to get it up and running
satisfactorily – or give up and return to Redmond.

also. The CD booted. I guess there is a different lens
for DVDs, and it was dirty.

I very seldom use the forum except to ask questions.
OK, that's what it's there for, but there are times
when I've felt I've had such a good deal over the last
few years from this OS and the forum that I don't
give enough in return. Not quite sure what it is I
could give, given the demands in my time anyway,
but maybe I could, from time to time, add something
stunningly funny, stupefyingly original, mindbending
etc. to the Sandbox. Or something.

In the end, I downloaded the latest PCLinuxOS KDE
2012.8. I thought I'd just see, out of interest, how
that compared. Now, I don't really like KDE. It has
never done it for me. This one, however, blew me
away. It installed flawlessly, updated flawlessly and
installed all my extra programs flawlessly. And
quickly. The wireless, like everything else, worked
out of the box. And it runs like the clappers – it
seems that a lot of the bloat, bells and whistles have
been relegated to the optional department. Great!
On top of that, it looks beautiful. I'm really knocked
out with it.

As luck would have it, they had salvaged a second
IDE hard disk from another family computer, and I
was able to swap out the bad one in about 10
minutes. With those two adjustments made, only the
unknown video mode error was causing an issue.
Hitting spacebar got it autodetected, but still had to
do that every boot.

Anyhow, having said that, I'm really here today to
say I've recently learned a very interesting lesson.
One of my stepsons, (25, doing an Oxford DPhil and
knows generally what he's talking about) who uses
another wellknown distro, told me he'd always got
the impression (don't know where from) that
PCLinuxOS was a bit clunky and oldfashioned. It
made me think. I've been using it now for about five
years, and I had to stop and ask myself was I still
using it after all that time simply because I was still
using it? Or because I thought it was the best? I
decided to try out a few others. I didn't leave
PCLinuxOS, but I did give half a dozen other top
distros, and a couple not in the top ten, a try – even
to the extent of installing them.
It was a fairly depressing and disappointing
experience. I struggled and became really frustrated
at some point with all of them  either in the install or
in using them, or both. The hardware didn't work or
the wireless was horribly difficult to configure; things
which were supposed to work just didn't; or using the
repositories
was
unbelievably
complicated.
Something screwed up at some point in each one
and I became really disillusioned  anyone coming
from Windows to Linux for the first time with one of
these would have either to twist his/her brain
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How you guys do it, I don't know, but you've put
together something here which leaves the
competition, as I've experienced it, standing and you
have my admiration and thanks. Brilliant. Here's to
another five years.
from catlord17
Yesterday I traveled to Orlando, Florida, 2 hours
drive away, to try to fix my friend's parents computer.
After 10 years of (very light) duty, Windows XP gave
up the ghost. Honestly, I don't know how it lasted
that long, but again … very light duty.
I got there, popped in the 2012.8 KDE DVD and …
no dice. It wouldn't read. I was also getting a
message that SMART was throwing errors on the
hard disk.
Fortunately, I had foreseen this possibility, had
downloaded PCLinuxOS LXDE, and burned a CD

I had some issues with the partitioner wanting me to
reboot over and over again when I tried using
custom partitions (whatever happened to only
rebooting after install?), but "Erase and use the
whole disk" made short work of that.
Then, we spent the rest of the day configuring and
installing. I had to uninstall several programs and
install several more in order to make it less
confusing for the users. Once I had it working, they
were impressed with how nice and clean it was, and
how fast.
There's no more Windows in that household
anymore … and they're perfectly happy with it that
way, after seeing how nice PCLinuxOS LXDE is.
Thanks, team. They'd have had to go without a
computer at all otherwise. Now they'll probably get
another 24 more years out of that computer before
it will need to be replaced. And to be honest, it gives
me a special thrill whenever I can kill a windows
install and replace it with PCLinuxOS.
Oh, and having experience with the sudden drop in
support calls from installing PCLinuxOS … thank
you for that too.
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Five New Testimonials
from cozzykim
Wahaaay,

PCLinuxOS is one slick piece of work. Thanks are
due for all the hard work to everyone who makes
this possible.

From ibi

After years of trying to convince SWMBO (She Who
Must Be Obeyed) that her Dell Inspiron 1525 would
always be a PITA with Vista installed, I persuaded
her to shell out for a new hard drive when the old
160GB drive was getting filled up.

The short version:
PCLinuxOS is awesome! It's given me an extremely
stable, lean OS to work, play, and learn on.

So, one 500GB Medion Drive 'n' Go later:

The tl;dr version:

1) Swapped new drive for old in the Medion caddy,
installed Vista (just to give her the confidence of a
fall back) on a 60GB partition

In June 2011, exasperated during my onemillionth
reboot of a Windows OS, I decided there had to be
something better out there. I knew Mac OSs were
praised as highly stable, but Mac hardware is
expensive. I had also heard of "Linux," a computer
geek OS that you operated by furiously typing green
text onto a black screen, like Samuel L. Jackson in
Jurassic Park.

2) Downloaded and installed PCLinuxOS 2012.08
with default partition sizes.
3) Plug in the old drive in its USB caddy and transfer
everything from Vista Documents folders.
4) Set up Thunderbird email accounts (she was
already using T'Bird) and import address books.

from geraldw321

5) Sit back and wait for questions/complaints. She:
"how do I …" Me: "there's an app for that."

Hello there, I'm geraldw. I'm new to PCLinuxOS, but
not new to Linux. I've run other distros in the past,
but never stayed with them. But this distro is great. I
love the Full Monty version.

She likes it, "I like the fonts and layouts, I like the
window decorations, I like x, I like y".
It obviously helps that she was using Thunderbird
and Google Chrome before.
Success
P.S. The internal mic is not working/showing up as a
distinct device in kmix or alsamixer, but I'll have a
look at that when she's not around.
I'm anticipating a much less labor/time intensive IT
support role from now on.
From the point of view of a new user, the latest
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PCLinuxOS is here to stay. Many thanks to the team
for putting together an excellent system.

I put it on my new Acer v771G 9875 laptop, which
has a core i7 3610QM processor @2.3ghz, a
Samsung 830 ssd @256gig, a Hitachi 750 gig
storage drive, Pioneer dvd burner, nVidia GT650m
video card ... on and on.
PCLinuxOS installed fine. I’ve been running it for a
month with only a few minor issues (trying to get
optimus working) and an occasional freeze, but
other than that, it’s a rocking system.
The group here has helped with info I found here
(and replies to a couple of questions), to configure
things to my liking and address my issues. I hope

When my Windows reboot was finally finished, I
opened my browser and did a Linux search. I saw
pics of some Linux OSs that actually had desktop
environments! Whatever happened to that imposing
terminal? Well, after about an hour researching
Linux, I decided it just might be doable.
My local library had a "Linux for Dummies" book that
came with an old Fedora CD. I installed that Fedora
distro on one of my junk PCs, and worked my way
through the book. It turned out that Linux, with a
GUI, was similar enough to Windows to navigate
easily. And, best of all for a cheapskate like me,
Linux was free! I was excited.
That Fedora distro was very old, and since my first
distro installation went so smoothly, I became
obsessed with trying all those distros out there. (You
know how it is at the beginning.) And there were a
lot of distros out there – more distros than I had
Windows reboots under my belt.
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So I spent a few days burning and installing
LiveCDs. Unfortunately, I had issues with a lot of
distros. Some of them wouldn't install on my PCs
that lacked "pae" support. Others wouldn't recognize
the wireless cards in my laptops. I was not so
excited anymore.

terminal looks really cool as I learn to program
Python! (Plus, I can now pull off a pretty decent
Samuel L. Jackson impression  the hypersonic
typing, the beautiful green text flowing effortlessly
across the terminal screen, the cigarette ashes
falling onto the keyboard.)

I eventually came upon PCLinuxOS, which was near
the top of the Distrowatch list. I was hooked!
PCLinuxOS installation was a breeze. No issues
with "pae" support. PCLinuxOS recognized the
wireless cards in two of my three laptops.
PCLinuxOS was similar enough to a Windows
environment as to make it just plain easy for a noob
like me.

Thank you, PCLinuxOS team! I hope I eventually
reach the point where I can contribute to the project
in a substantive way.

In my opinion, that's one of the real beauties of
PCLinuxOS. It just works straight away, giving the
user, if so inclined, time to explore what's really
under the Linux hood. And I was so inclined.

Connect

All your
PCLinuxOS
connections in one
convenient location!

Screenshot
Screenshot Showcase
Showcase

My great experience with PCLinuxOS made me
want to learn everything I could about Linux – the
command line and all those cool things I read about
in the forums – ssh, scp, setting up NFS and Samba
servers. All of it.
So, in recent months, I've been working my way
through William Shotts' excellent book, "The Linux
Command Line." I also recently purchased Soyinka's
"Linux Administration: A Beginner's Guide." Also
excellent. I now have three desktops and three
laptops (all PCLinuxOS) networked via NFS. I'm
sshing from one PC to another and exchanging files
via Filezilla – not because I have to, just because I
can. Next on the list: set up a Samba server so I can
network my two remaining Windows PCs also.
I have PCLinuxOS to thank for all this. It's given me
a new hobby and driven me to learn all I can about
systems administration. Want proof of what a geek
I'm becoming? Well, I'm composing this (rather long
now, sorry) post on vim, whose terminal layout is just
awesome, because I created my own colorscheme
and "vimmed" my .vimrc file. Why? So that the
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Posted by Stephen, January 17, 2013, running KDE4.
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More Screenshot Showcase

Above: Posted by RobNJ, January 5, 2013, running LXDE.
Below: Posted by Crow, January 15, 2013, running LXDE.
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Above: Posted by agmg, January 17, 2013, running KDE4.
Below: Posted by GermanTux, January 2, 2013, running KDE4.
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